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CAUTION: Safety Instructions
Use the following safety guidelines to help ensure your own personal safety and to help 
protect your device and working environment from potential damage.

SAFETY: General

• Do not attempt to service the device yourself unless you are a trained service 
technician. Always follow installation instructions closely.

• If you use an extension power cable with your AC adapter, ensure that the total 
ampere rating of the products plugged in to the extension power cable does not exceed 
the ampere rating of the extension cable.

• Do not push objects into air vents or openings of your device. Doing so can cause fire 
or electric shock by shorting out interior components.

• Keep your device away from radiators and heat sources. Also, do not block cooling 
vents. Avoid placing loose papers underneath your device; do not place your device in 
a closed-in wall unit or on a bed, sofa, or rug.

• Place the AC adapter in a ventilated area, such as a desk top or on the floor, when you 
use it to run the device or to charge the battery. Do not cover the AC adapter with 
papers or other items that will reduce cooling; also, do not use the AC adapter inside a 
carrying case.

• The AC adapter may become hot during normal operation of your device. Use care 
when handling the adapter during or immediately after operation.

• Do not use your device in a wet environment, for example, near a bath tub, sink, or 
swimming pool or in a wet basement.

• If your device includes an integrated or optional (PC Card) modem, disconnect the 
modem cable if an electrical storm is approaching to avoid the remote risk of electric 
shock from lightning via the telephone line.

• To help avoid the potential hazard of electric shock, do not connect or disconnect any 
cables or perform maintenance or reconfiguration of this product during an electrical 
storm. Do not use your device during an electrical storm unless all cables have been 
disconnected and the device is operating on battery power.

• If your device includes a modem, the cable used with the modem should be 
manufactured with a minimum wire size of 26 American wire gauge (AWG) and an 
FCC-compliant RJ-11 modular plug.

• PC Cards may become very warm during normal operation. Use care when removing 
PC Cards after their continuous operation.

• Before you clean your device, disconnect the device from the electrical outlet. Clean 
your device with a soft cloth dampened with water. Do not use liquid or aerosol 
cleaners, which may contain flammable substances.
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12 CAUTION: Safety Instructions

SAFETY: Power

• Use only the Dell-provided AC adapter approved for use with this device. Use of 
another AC adapter may cause a fire or explosion.

• Before you connect the device to an electrical outlet, check the AC adapter voltage 
rating to ensure that the required voltage and frequency match the available power 
source.

• To remove the device from all power sources, turn the device off, disconnect the AC 
adapter from the electrical outlet, and remove the battery installed in the battery bay.

• To help prevent electric shock, plug the AC adapter and device power cables into 
properly grounded power sources. These power cables may be equipped with 3-prong 
plugs to provide an earth grounding connection. Do not use adapter plugs or remove 
the grounding prong from the power cable plug. If you use a power extension cable, 
use the appropriate type, 2-prong or 3-prong, to mate with the AC adapter power 
cable.

• Be sure that nothing rests on your AC adapter’s power cable and that the cable is not 
located where it can be tripped over or stepped on.

• If you are using a multiple-outlet power strip, use caution when plugging the AC 
adapter’s power cable into the power strip. Some power strips may allow you to insert 
the plug incorrectly. Incorrect insertion of the power plug could result in permanent 
damage to your device, as well as risk of electric shock and/or fire. Ensure that the 
ground prong of the power plug is inserted into the mating ground contact of the 
power strip.

SAFETY: Battery

• Use only Dell™ battery modules that are approved for use with this device. Use of 
other types may increase the risk of fire or explosion.

• Do not carry a battery pack in your pocket, purse, or other container where metal 
objects (such as car keys or paper clips) could short-circuit the battery terminals. The 
resulting excessive current flow can cause extremely high temperatures and may result 
in damage to the battery pack or cause fire or burns.

• The battery poses a burn hazard if you handle it improperly. Do not disassemble it. 
Handle a damaged or leaking battery pack with extreme care. If the battery is 
damaged, electrolyte may leak from the cells and may cause personal injury.

• Keep the battery away from children.

• Do not store or leave your device or battery pack near a heat source such as a radiator, 
fireplace, stove, electric heater, or other heat-generating appliance or otherwise expose 
it to temperatures in excess of 60ºC (140ºF). When heated to excessive temperatures, 
battery cells could explode or vent, posing a risk of fire.
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• Do not dispose of your device’s battery in a fire or with normal household waste. 
Battery cells may explode. Discard a used battery according to the manufacturer’s 
instructions or contact your local waste disposal agency for disposal instructions. 
Dispose of a spent or damaged battery promptly.

SAFETY: Air Travel

• Certain Federal Aviation Administration regulations and/or airline-specific restrictions 
may apply to the operation of your Dell device while you are on board an aircraft. For 
example, such regulations/restrictions may prohibit the use of any personal electronic 
device (PED) that has the capacity for intentional transmission of radio frequency or 
other electromagnetic signals while on an aircraft.

– In order to best comply with all such restrictions, if your Dell portable device is 
equipped with Dell TrueMobile™ or some other wireless communication device, 
please disable this device before you board the aircraft and follow all instructions 
provided by airline personnel with regard to such device.

– Additionally, the use of any PED, such as a portable device, may be prohibited in 
aircraft during certain critical phases of flight, for example, takeoff and landing. 
Some airlines may further define the critical flight phase as any time the aircraft 
is below 3050 m (10,000 ft). Please follow the airline’s specific instructions as to 
when the use of a PED is allowed.

SAFETY: Electromagnetic Compatibility Instructions

Use shielded signal cables to ensure that you maintain the appropriate electromagnetic 
compatibility classification for the intended environment. For parallel printers, a cable is 
available from Dell. If you prefer, you can order a cable from Dell at its worldwide website at 
www.dell.com.

Static electricity can harm electronic components inside your device. To prevent static 
damage, discharge static electricity from your body before you touch any of your device’s 
electronic components, such as a memory module. You can do so by touching an unpainted 
metal surface.

WARNING: Handling the cord on this product, or cords associated with 
accessories sold with this product, will expose you to lead, a chemical known 
to the State of California to cause birth defects or other reproductive harm. 
Wash your hands after handling the cord. 
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14 When Using Your Device

When Using Your Device
Observe the following safe-handling guidelines to prevent damage to your device:

• When setting up the device for work, place it on a level surface.

• When traveling, do not check the device as baggage. You can put your device through 
an X-ray security machine, but never put your device through a metal detector. If you 
have the device checked by hand, be sure to have a charged battery available in case 
you are asked to turn on the device.

• When traveling, do not place the device in overhead storage compartments where it 
could slide around. Do not drop your device or subject it to other mechanical shocks.

• Protect your device, battery, and hard drive from environmental hazards such as dirt, 
dust, food, liquids, temperature extremes, and overexposure to sunlight.

• When you move your device between environments with very different temperature 
and/or humidity ranges, condensation may form on or within the device. To avoid 
damaging the device, allow sufficient time for the moisture to evaporate before using 
the device.

 NOTICE: When taking the device from low-temperature conditions into a warmer 

environment or from high-temperature conditions into a cooler environment, allow the 

device to acclimate to room temperature before turning on power. 

• When you disconnect a cable, pull on its connector or on its strain-relief loop, not on 
the cable itself. As you pull out the connector, keep it evenly aligned to avoid bending 
any connector pins. Also, before you connect a cable make sure both connectors are 
correctly oriented and aligned.

• Handle components with care. Hold a component such as a memory module by its 
edges, not its pins.

• Clean the display with a soft, clean cloth and water. Apply the water to the cloth; then 
stroke the cloth across the display in one direction, moving from the top of the display 
to the bottom. Remove moisture from the display quickly and keep the display dry. 
Long-term exposure to moisture can damage the display. Do not use a commercial 
window cleaner to clean your display.

SAFETY: Ergonomic Computing Habits

 CAUTION: Improper or prolonged keyboard use may result in injury.

 CAUTION: Viewing the display or external monitor screen for extended periods of 

time may result in eye strain.
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SAFETY: Protecting Against Electrostatic Discharge

Static electricity can harm electronic components inside your device. To prevent static 
damage, discharge static electricity from your body before you touch any of your device’s 
electronic components, such as a memory module. You can do so by touching an unpainted 
metal surface.

You can also take the following steps to prevent damage from electrostatic discharge (ESD):

• When unpacking a static-sensitive component from its shipping carton, do not 
remove the component from the antistatic packing material until you are ready to 
install the component. Just before unwrapping the antistatic packaging, be sure to 
discharge static electricity from your body.

• When transporting a sensitive component, first place it in an antistatic container or 
packaging.

• Handle all sensitive components in a static-safe area. If possible, use antistatic floor 
pads and workbench pads.

SAFETY: Battery Disposal

Your device uses a lithium-ion battery and a rechargeable NiMH battery. For 
instructions about replacing the batteries in your device, see "Using the Battery" 
on page 21. 

Do not dispose of the battery along with household waste. Contact your local 
waste disposal agency for the address of the nearest battery deposit site.

Finding Information

What Are You Looking For? Find It Here:

How to set up my device and 
information on the connectors and 
buttons on my device

The setup diagram and the Dell™ 
Owner’s Manual

Information on using my device Dell Owner’s Manual and Pocket PC 
Help.

To view Help, tap the Start button and 
tap Help.

Additional programs that can be 
installed on my device

Dell Companion CD

Information on using programs on my 
device

Pocket PC Help and, if available, tap 
Help within a specific program
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16 Finding Information

Connecting to and synchronizing with 
a computer

Dell Owner’s Manual and Microsoft® 
ActiveSync® Help on your computer. 
To view Help, click Help and click 
Microsoft ActiveSync Help.

Last-minute updates and detailed 
technical information

The readme files, located in the 
ActiveSync folder on the computer and 
on the Dell Companion CD.

Up-to-date information on your 
Pocket PC

www.microsoft.com/windowsmobile

My Service Tag Label located in the battery slot 
(remove the battery)

What Are You Looking For? Find It Here:
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Front, Side, and Back Views

Using the Battery

Connecting to a Computer

Checking Built-In Storage

Using Secure Digital Memory Cards

Performing a Reset
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18 About Your Device

Front, Side, and Back Views
 CAUTION: Before performing any of the procedures in this section, read and 

follow the safety instructions on page 11.

Front and Side Views

INFRARED SENSOR—The infrared sensor lets you transfer files from your device to 
another infrared-compatible device without using cable connections.

MICROPHONE—Allows you to record audio.

SECURE DIGITAL CARD SLOT—See "Using Secure Digital Memory Cards" on page 27 
for information on using Secure Digital memory cards.

Secure Digital card slot (top)

stylus 

(extended)

power button

touch screen

scroll 

dial

navigator button

wireless/

Windows Media

Player on/off 

button

Home button

Contacts button

Calendar button

headphone 

connector

infrared sensor (top)

Messaging button

microphone

record button

wireless antenna (optional)
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WIRELESS ANTENNA—Allows you to transmit data (optional).

• When Bluetooth is in use, the antenna lights blue. 

• When Wi-Fi is in use, the antenna lights green. 

STYLUS—Use the stylus to write or draw on the screen. To remove the stylus, pull it 
straight up and out of the holder. To avoid losing the stylus, store the stylus in the 
holder when you are not using it. Ensure that the stylus is oriented correctly when 
you replace it in the slot.

POWER BUTTON—Press the power button to turn the device on or off. Press and hold 
the power button to dim the display. Repeat to light the display.

• When the device is connected to external power and the main battery is fully 
charged, the power button light is solid green.

• When the main battery charge is low, the power button light flashes amber.

• When the battery is being charged, the power button light is solid amber. 

• When the device relays a notification, the power button light rapidly flashes 
green.

TOUCH SCREEN—Use the touch screen and the stylus to enter information into your 
device. See "Entering Information" on page 41. 

WIRELESS OR MICROSOFT
® WINDOWS MEDIA

® PLAYER ON/OFF BUTTON—On wireless devices, 
the button turns the wireless module on and off. Turn off the module to conserve 
power. On non-wireless devices, the button turns Windows Media Player on and off.

HOME BUTTON—Press this button to launch Home or to turn on the device.

MESSAGING BUTTON—Press this button to launch Messaging or to turn on the 
device.

NAVIGATOR BUTTON—Press the right, left, top, or bottom of the navigator button to 
move the cursor on the screen. Press the center to enter a selection.

CONTACTS BUTTON—Press this button to launch Contacts or to turn on the device.

CALENDAR BUTTON—Press this button to launch Calendar or to turn on the device.

RECORD BUTTON—See "Recording a Message" on page 50 for information on using 
the record button.

SCROLL DIAL

• Press the scroll dial to perform actions similar to pressing <Enter> on a keyboard.

• Rotate the scroll dial up or down to perform actions similar to using the up- and 
down-arrow keys on a keyboard.

For information on the functionality of the scroll dial within programs, see Pocket 
PC Help on your device.

HEADPHONE CONNECTOR—Attach headphones.
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20 About Your Device

Back View

BATTERY LOCK—Use this switch to release and remove the main battery. See "Installing 
and Removing the Battery" on page 21.

BATTERY—See "Using the Battery" on page 21 for information on the main battery.

SPEAKER—Tap the speaker icon to adjust the volume.

CRADLE/SYNC CABLE CONNECTOR—Connect a cradle or sync cable. See "Connecting to 
a Computer" on page 23.

RESET BUTTON—See "Performing a Reset" on page 28 for information on using the 
reset button.

battery

stylus (secured)

battery lock

cradle/sync cable 

connector (bottom)

reset button

speaker
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Using the Battery
 NOTICE: Do not use your device until you have charged the main battery for at 

least 8 hours for the first charge. 

Before you use your device for the first time, you must install and charge the 
battery. Once the battery is charged, use the power properties to monitor the 
battery charge. See Pocket PC Help on the device for more information. 

Installing and Removing the Battery

To install the battery:

1 Ensure that the device is turned off.

2 Insert the left side of the battery into the battery slot at an angle, and 
lower the right side into the slot until it clicks.

battery
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22 About Your Device

To remove the battery:

1 Insert the tip of the stylus into the battery lock.

2 Slide and hold the lock in the unlock position.

3 Lift the battery out of the slot.

 NOTE: Your Service Tag is located underneath the battery. You need your 

Service Tag if you access Dell Support at support.dell.com or if you call Dell for 

customer service or technical support.

Charging the Battery

Use one of the following options to charge the main battery:

• Connect the AC adapter directly to the charger adapter and then to the 
device and to an electrical outlet.

• Connect the AC adapter directly to the sync cable and then to the 
device and to an electrical outlet.

• Connect the AC adapter to the cradle, and insert the device into the 
cradle. See "Using the Cradle" on page 23 for more information.

Charging the main battery and internal backup battery from empty to full 
takes 8 hours the first time and 4 hours thereafter, whether the device is on 
or off. 

battery

stylus

battery lock



About Your Device 23

If the main battery is critically low, the device enters "deep sleep" mode and 
the device is powered off. 

To recover from a critically low battery: 

1 Plug in the AC adapter or replace the main battery with a non-empty 
battery. 

2 Press the power button to power on. 

If you remove the main battery, the internal backup battery can last for up to 
30 minutes in "deep sleep" mode. Do not remove the main battery if the 
backup battery power is low. 

With normal use, the device will power off if the device is left unused for a 
user-defined period of time. See "System Tab" on page 54 for information 
about Power to set the amount of time that the device can remain idle 
before it turns off. 

Connecting to a Computer
You either connect your device to a computer using a cradle or directly to a 
computer using a sync cable. Connect your device to a computer to:

• Add programs to your device. See "Adding Programs Using Microsoft® 
ActiveSync®" on page 76 for more information.

• Synchronize data on your device with data on your computer.

For information on synchronizing your data, see the following resources:

• "Using Microsoft® ActiveSync®" on page 57

• ActiveSync Help on your computer

• ActiveSync Help on your device

Using the Cradle

 NOTE: Depending on the configuration of your device, the cradle is optional. 

You can use the cradle to:

• Synchronize the data on your device with the data on your computer. 

• Power the device with AC power to conserve battery power.
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24 About Your Device

• Charge the main battery. See "Using the Battery" on page 21 for more 
information.

• Charge a spare battery.

 NOTE: Before connecting your device to a computer for the first time, ensure 

that you install ActiveSync on the computer from the Dell™ Companion CD. 

To connect your device to the cradle:

1 Place the cradle on a flat, level surface near your computer.

2 Connect the cradle cable to the USB connector on your computer.

power 

cord

cradle

USB connection 

to the computer

AC adapter

cradle cable
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3 Connect the AC adapter to the cradle and to an electrical outlet.

4 Align the connector on the bottom of the device with the connector on 
the cradle, and, keeping the front of the device flush with the front of 
the cradle, lower the device onto the cradle. 

When the device is docked in the cradle, the DELL™ logo on the cradle 
lights up and the connection status icon appears on the command bar (see 
page 33).

The spare battery status light on the cradle operates as follows:

• Green — The spare battery is fully charged.

• Amber — The spare battery is charging.

 NOTE: The power button on the device indicates the charge status of the main 

battery. See the description of the power button lights on page 19 for more 

information.

To remove the device from the cradle, pull the device straight up and out of 
the cradle.

front of 

cradle

stylus holder (2)

spare battery 

charger
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26 About Your Device

Using the Sync Cable

Use the sync cable to connect your device directly to the computer without 
using the cradle.

 NOTE: Depending on the configuration of your device, the sync cable is 

optional.

To connect the sync cable:

1 Connect one end of the cable to the USB connector on your computer.

2 Connect the other end of the cable to your device.

 NOTICE: To avoid damaging the connector, press the two buttons on the sides 

of the connector to release the self-lock structure before pulling the connector 

out of the device. 

sync cable connector

USB connection 

to the computer

AC adapter

sync cable

device connector

power 

cord

buttons (2)
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Checking Built-In Storage
The amount of on-board flash memory in your device is dependent on the 
device configuration and the operating-system image size. The memory is 
non-volatile, so the data saved here is not lost even if the device is totally out 
of power. 

To check the available non-volatile memory space on your device: 

1 Tap the Start button and tap Settings.

2 Tap the System tab and tap Memory.

3 Tap the Storage Card tab, and then select Built-in Storage from the 
drop-down menu to display the available space. 

Using Secure Digital Memory Cards
Use Secure Digital memory cards to save or back up data.

To install a Secure Digital memory card:

1 If a card is already installed, press in the card to release it, and then 
remove it.

blank
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28 About Your Device

2 Ensure that the card is oriented correctly, and slide it into the slot until 
you feel a click.

 NOTICE: Do not force the card. If you feel resistance, remove the card, check 

the orientation, and reinsert it.

See the documentation that came with the card for information on using the 
card.

Performing a Reset

Soft Reset

When you perform a soft reset, the device deletes any data that has not been 
saved but saves any data that has been stored in memory. Try performing a 
soft reset if the device does not respond when you tap the display or press a 
button.

To perform a soft reset, use the stylus to press the reset button.

stylus

reset button



About Your Device 29

Hard Reset

 NOTICE: When you perform a hard reset, you lose all the data stored and any 

programs you installed on your device.

Perform a hard reset if:

• You want to delete all the data stored on your device.

• You forget your password and need to clear it.

• Your device is experiencing severe operational problems and you have 
already attempted a soft reset.

 NOTICE: It is strongly recommended that you back up your data before you 

perform a hard reset. See ActiveSync Help on your computer for more 

information.

To perform a hard reset:

1 Press and hold the power button.

2 With the stylus, hold the reset button for about 2 seconds.

3 Follow the instructions on the screen.
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Using Microsoft® Windows 
Mobile™ 2003 Second Edition

Device Buttons and the Stylus

Today Screen

Status Icons

Programs

Navigation Bar and Command Bar

Pop-Up Menus

Finding and Organizing Information

Backing Up Data
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32 Using Microsoft® Windows Mobile™ 2003 Second Edition

Device Buttons and the Stylus
Your device has hardware buttons that control actions and scroll functions, 
and a stylus for selecting items and entering information.

On the device, the stylus replaces the mouse:

• Tap — Touch the screen once with the stylus to open items and select 
options.

• Drag — Hold the stylus and drag across the screen to select text and 
images. Drag in a list to select multiple items.

• Tap and hold — Tap and hold the stylus on an item to see a list of 
actions available for that item. On the pop-up menu that appears, tap 
the action you want to perform.

See "Entering Information" on page 41 for more information.

Today Screen
When you turn on your device for the first time each day (or after 4 hours of 
inactivity), the Today screen appears. You can also view the Today screen by 
tapping the Start button and then tapping Today. The Today screen displays 
the date and information about the device owner, today’s calendar, and 
important tasks. To customize the Today screen:

1 Tap the Start button and tap Settings.

2 Tap the Personal tab and tap Today.

Use the Appearance tab to change the background that displays on the 
Today screen.

Use the Items tab to change the items that appear on the Today screen. 
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Start 

button

connection 

status icon

New items menu

volume control iconconnection 

configuration icon
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34 Using Microsoft® Windows Mobile™ 2003 Second Edition

Status Icons
 NOTE: If there is not enough room to display all notification icons, the 

notification icon, , displays. Tap the notification icon to view all 

notifications.

Icon Description

Turns sound on and off.

Backup battery is low.

Main battery is charging.

Main battery is low.

Main battery is very low.

Main battery is full.

Connection is active. Tap the icon to configure 
connections.

Connection is not detected.

Wireless network is detected.

Synchronization is beginning or ending.

Synchronization is occurring.
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Programs
You can switch from one program to another by selecting a program from the 
Start menu. To access programs that are not listed in the Start menu, tap the 
Start button, tap Programs, and then tap the program name.

 NOTE: Some programs have abbreviated labels for check boxes and drop-

down menus. To see the full spelling of an abbreviated label, tap and hold the 

stylus on the label. Drag the stylus off the label so that the command is not 

carried out.

Program Buttons

You can also switch to some programs by pressing a program button. Your 
device has four program buttons located on the front of the device. The 
icons on the buttons identify the programs to which they switch. By default, 
the buttons launch Home, Messaging, Contacts, and Calendar.

New instant message(s).

New e-mail message(s).

Icon Description
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36 Using Microsoft® Windows Mobile™ 2003 Second Edition

Switcher Bar

You can also use Switcher Bar to switch to or close open programs. To launch 
Switcher Bar:

1 Tap the Start button and tap Settings.

2 Tap the System tab and tap Switcher Bar.

The Switcher Bar icon, , appears in the navigation bar.

Tap  to view a list of all open programs. In the Switcher Bar menu:

• Tap Brightness settings or Power settings to configure those settings.

• Tap a program name to switch to that program.

• Tap Exit current program to close the current program.

• Tap Exit all programs to close all open programs.

• Tap Exit Switcher Bar to close the menu.

The following table contains a partial list of programs that are on your 
device. See the Dell™ Companion CD for additional programs that you can 
install on your device.

Icon Program Description

ActiveSync
Synchronize information 
between your device and 
your computer.

Calendar
Keep track of your 
appointments and create 
meeting requests.

Contacts
Keep track of your friends 
and colleagues.

Messaging
Send and receive e-mail 
messages.

Pocket Internet Explorer

Browse websites and WAP 
sites, and download new 
programs and files from the 
Internet.
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Navigation Bar and Command Bar
The navigation bar is located at the top of the screen. It displays the active 
program and current time and allows you to switch to other programs and 
close screens. 

Use the command bar at the bottom of the screen to perform tasks in 
programs. The command bar includes menu names, icons, and the input 
panel icon. To create a new item in the current program, tap New. To see the 
name of an icon, tap and hold the stylus on the icon. Drag the stylus off the 
icon so that the command is not carried out.

Notes
Create handwritten or 
typed notes, drawings, or 
recordings.

Tasks Keep track of your tasks.

Pocket Excel

Create new workbooks or 
view and edit Excel 
workbooks that you created 
on your computer.

MSN Messenger
Send and receive instant 
messages with your MSN 
Messenger contacts.

Pocket Word

Create new documents or 
view and edit Word 
documents that you created 
on your computer.

Icon Program Description
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38 Using Microsoft® Windows Mobile™ 2003 Second Edition

Pop-Up Menus
With pop-up menus, you can quickly select an action for an item. For 
example, you can use the pop-up menu in the contact list to delete a 
contact, make a copy of a contact, or send an e-mail message to a contact. 
The actions in the pop-up menus vary from program to program. To access a 
pop-up menu, tap and hold the stylus on an item name. When the menu 
appears, lift the stylus and tap the action you want to perform. To close the 
menu without performing an action, tap anywhere outside the menu.

navigation bar

Start menu

command bar
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Finding and Organizing Information
The Find feature on your device helps you to quickly locate information. 

On the Start menu, tap Find. Enter the item that you want to find, select a 
data type from the drop-down menu, and then tap Go to start the search.

You can also use the File Explorer to find files on your device and to organize 
your files into folders. On the Start menu, tap Programs and tap File 
Explorer.
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40 Using Microsoft® Windows Mobile™ 2003 Second Edition

Backing Up Data
To prevent or minimize data loss, you should periodically back up the data 
stored on your device. Use ActiveSync to synchronize the files on your device 
with the files on your computer. You can also drag and drop files from your 
device to your computer using Windows Explorer. See the ActiveSync Help 
on your computer for additional information.

sort menu

folder location
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Entering Text Using the Input Panel

Writing on the Screen

Drawing on the Screen

Recording a Message

Using My Text
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42 Entering Information

You have several options for entering information:

• Use the input panel to enter typed text using the soft keyboard or 
another input method.

• Write directly on the screen with the stylus.

• Draw pictures on the screen with the stylus.

• Speak into your device microphone to record a message. 

Use Microsoft® ActiveSync® to synchronize or copy information from your 
computer to your device. For more information on ActiveSync, see 
ActiveSync Help on your computer.

Entering Text Using the Input Panel
Use the input panel to enter information in any program on your device. You 
can type using the soft keyboard or write using Letter Recognizer, Block 
Recognizer, or Transcriber. The characters appear as typed text on the 
screen.

To show or hide the input panel, tap the input panel icon. Tap the arrow 
next to the input panel icon to change input methods.

When you use the input panel, your device anticipates the word you are 
typing or writing and displays it above the input panel. When you tap the 
displayed word, the word is inserted at the insertion point. The more you use 
your device, the more words it learns to anticipate.

input panel icon
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To change word suggestion options, such as the number of words suggested:

1 Tap the Start button and tap Settings.

2 Tap the Personal tab, tap Input, and then tap the Word Completion 
tab.

3 Select the desired settings and tap OK.

Typing With the Soft Keyboard

1 Tap the arrow next to the input panel icon and tap Keyboard.

2 Tap the keys on the soft keyboard with your stylus.

Letter Recognizer

Letter Recognizer allows you to use your stylus to write letters on the screen 
as you would write them on paper.

suggested words
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44 Entering Information

 NOTE: Letter Recognizer is included with the English, French, German, Italian, 

and Spanish operating systems. Other versions do not support Letter 

Recognizer.

1 Tap the arrow next to the input panel icon and tap Letter Recognizer.

2 With your stylus, write a letter between the lines that appear on the 
bottom of the screen. 

The letters are converted to typed text on the screen. For specific 
instructions on using Letter Recognizer, tap the question mark next to 
the writing area.

 NOTE: Tap Demo to learn the character strokes that the device can recognize.

Block Recognizer

Block Recognizer allows you to use character strokes that are similar to those 
used on other handheld devices.

 NOTE: Block Recognizer is included with the English, French, German, Italian, 

and Spanish operating systems. Other versions do not support Block 

Recognizer.

1 Tap the arrow next to the input panel icon and tap Block Recognizer.

2 Using your stylus, write the appropriate character stroke in the box that 
appears at the bottom of the screen.

The character strokes are converted to typed text on the screen. For 
specific instructions on using Block Recognizer, tap the question mark 
next to the writing area.

 NOTE: Tap Demo to learn the character strokes that the device can recognize.

Transcriber

Transcriber allows you to write anywhere on the screen using the stylus 
similar to the way that you would write on paper. Unlike Letter Recognizer 
and Block Recognizer, you can write a sentence or more, and then pause to 
let Transcriber change the written characters to typed characters.
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 NOTE: Transcriber is included with the English, French, and German operating 

systems. Other versions do not support Transcriber.

1 Tap the arrow next to the input panel icon and tap Transcriber.

2 With your stylus, write anywhere on the screen.

When you pause, Transcriber converts your written characters to typed 
characters. For specific instructions on using Transcriber, tap the 
question mark in the lower right hand corner of the screen.

Editing Typed Text

To edit or format typed text, you must select it first:

1 Drag the stylus across the text that you want to select.

2 Tap and hold the selected text.

3 Tap the appropriate editing command in the pop-up menu.

You can also tap Edit at the bottom of the screen to select editing 
commands.

Writing on the Screen
In any program that accepts written text, such as the Notes program and the 
Notes tab in some programs, you can use your stylus to write directly on the 
screen. You can edit and format what you have written and convert the 
information to text at a later time.

 NOTE: Some programs that accept written text may not have the pen icon. See 

the documentation for that program to find out how to switch to writing mode.

To write on the screen, tap the pen icon to switch to writing mode. This 
action displays lines on the screen to help you write.
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46 Entering Information

Editing Written Text

To edit or format written text, you must select it first:

1 Tap the pen icon to deselect it.

2 Drag the stylus across the text that you want to select.

3 Tap and hold the selected text.

4 Tap the appropriate editing command in the pop-up menu.

You can also tap Edit at the bottom of the screen to select editing 
commands.

5 Tap the pen icon to switch back to writing mode.

To convert written text to print-style text, tap Tools and tap Recognize.

pen icon
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If you want to convert only certain words, select them before tapping 
Recognize (or tap and hold the selected words and then tap Recognize on 
the pop-up menu). If a word is not recognized, it is not converted to print-
style text.

If the conversion is incorrect, you can select different words from a list of 
alternatives or return to the original written text:

1 Tap and hold the incorrect word. 

2 On the pop-up menu, tap Alternates. 

A menu with a list of alternative words appears.

3 Tap the correct word, or tap the written text at the top of the menu to 
return to the original written text.
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48 Entering Information

Tips for getting good recognition:

• Write neatly.

• Write on the lines and draw descenders below the line. Write the cross 
of the "t" and apostrophes below the top line so that they are not 
confused with the word above. Write periods and commas above the 
line.

• For better recognition, try changing the zoom level to 300 percent 
using the Tools menu.

• Write the letters of a word closely and leave big gaps between words so 
that the device can easily determine where words begin and end.

• Hyphenated words, foreign words that use special characters such as 
accents, and some punctuation cannot be converted.

• You cannot add written text to a word to change it after the word has 
been recognized. You must delete the written word and write the new 
word.

alternate 

words
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Drawing on the Screen
You can draw on the screen the same way that you write on the screen; 
however, selecting and editing drawings is different than selecting and 
editing written text. For example, selected drawings can be resized, while 
written text cannot.

Creating a Drawing

 NOTE: To zoom in or out on your drawing, tap Tools and tap a zoom level.

Cross three ruled lines on your first stroke. A drawing box appears. 
Subsequent strokes that touch or are inside of the drawing box become part 
of the drawing. Drawings that do not cross three ruled lines are treated as 
written text.

drawing box
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50 Entering Information

Editing a Drawing

To edit or format a drawing, you must select it first:

1 Tap and hold the stylus on the drawing until the selection handle 
appears. 

To select multiple drawings, deselect the pen icon and drag to select 
the drawings.

2 Tap and hold the selected drawing and tap an editing command on the 
pop-up menu.

3 You can cut, copy, and paste selected drawings by tapping and holding 
the selected drawing and then tapping an editing command on the 
pop-up menu.

You can also tap Edit at the bottom of the screen to select editing 
commands.

To resize a drawing, ensure that the Pen icon is not selected, and drag a 
selection handle.

Recording a Message
In any program where you can write or draw on the screen, you can also 
quickly capture thoughts, reminders, and phone numbers by recording a 
message. In Calendar, Tasks, and Contacts, you can include a recording in 
the Notes tab. In the Notes program, you can either create a stand-alone 
recording or include a recording in a written note. If you want to include the 
recording in a note, open the note first. In the Messaging program, you can 
add a recording to an e-mail message. 

To record a message: 

1 Hold the microphone near your mouth or other source of sound.

2 Press and hold the Record button on the side of your device until it 
beeps.

3 While holding down the Record button, make your recording.

4 To stop recording, release the Record button. 

The device beeps twice. The new recording appears in the note list or 
as an embedded icon.
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 NOTE: You can also make a recording by tapping the Record icon on the 

Recording toolbar.

To play a recording, tap the name of the recording in the list or tap the 
speaker icon in the note.

Using My Text
When using Messaging or MSN Messenger, use My Text to quickly insert 
preset or frequently used messages. To insert a message, tap My Text and tap 
a message.

 NOTE: You can add text to a My Text message after you insert the message.

To edit a My Text message:

1 In Messaging or MSN Messenger, tap Tools.

2 Tap Edit My Text Messages.

3 Make the changes and tap OK.
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Adjusting Settings

Personal Tab

System Tab

Connections Tab
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You can adjust the device settings to suit the way you work. To see available 
options, tap the Start button and tap Settings.

 NOTE: Depending on the features of your device, you might have additional 

tabs and additional items on the tabs.

See Pocket PC Help on your device for additional information on adjusting 
settings (tap the Start button and tap Help).

Personal Tab
• Buttons — Assign the programs that launch when you press the 

hardware buttons.

• Input — Adjust the settings for input method, word completion, and 
other options.

• Menus — Add or remove items from the Start menu.

• Owner Information — Enter your contact information.

• Password — Set a password to protect the data stored on your device.

• Sounds & Notification — Adjust the volume and set notifications. See 
"Notifications" on page 74 for more information.

• Today — Customize the look and the information that is displayed on 
the Today screen.

System Tab
• About — Find information about Microsoft® Windows Mobile™ 2003 

Second Edition and your device.

• Brightness — Adjust the brightness settings to conserve power.

• Certificates — View or delete certificates stored on your device. 
Certificates help establish your identity and the identity of other 
computers to prevent unauthorized users from accessing your data.

• Clock & Alarms — Change the time or set the alarm.

• Memory — Screen setting allows you to select the screen orientation 
that you want to use. 

• Microphone — Adjust the microphone gain.
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• Power — Check the battery or charge status. Set the amount of time 
that the device can remain idle before it turns off on the Advanced tab.

• Regional Settings — View and change the formatting for regional 
settings, such as currency, time, and date.

• Remove Programs — Remove programs from your device. For more 
information, see "Adding and Removing Programs" on page 75.

• Screen — Adjust the screen if your device is not responding accurately 
to taps, and select the screen orientation that you want to use.

• Switcher Bar — Adjust the settings of the Switcher Bar program 
launcher utility.

• System Information — View technical information about your device.

Connections Tab
• Beam — Receive infrared beams from other devices.

• Bluetooth — Turn the Bluetooth™ radio on and off, and create and 
edit bonded devices. By default, the Bluetooth radio is off.

• Connections — Add and configure modem or server connections.

• Dell WLAN Utility — Available only on devices with Wi-Fi. 

• Network Cards — Configure your network adapter settings.
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Using Microsoft® ActiveSync®

About ActiveSync

Installing and Using ActiveSync
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About ActiveSync
You can synchronize the information on your computer with the 
information on your device with ActiveSync. Synchronization compares the 
data on your device with the data on your computer and updates both with 
the most recent information. For example:

• Keep Microsoft Pocket Outlook data up-to-date by synchronizing your 
device with Microsoft Outlook data on your computer. 

• Synchronize Microsoft Word and Microsoft Excel files between your 
device and your computer. Your files are automatically converted to the 
correct format.

 NOTE: By default, ActiveSync does not automatically synchronize all types of 

information. You can change ActiveSync options to synchronize specific types 

of information.

With ActiveSync, you can also:

• Back up and restore your device data.

• Copy (rather than synchronize) files between your device and your 
computer. 

• Select a synchronization mode to control when synchronization occurs. 
For example, you can synchronize continuously or only when you select 
the synchronize command.

• Select which information types are synchronized and control how 
much data is synchronized. For example, you can choose how many 
weeks of past appointments you want synchronized.

To synchronize your data, you need both the Microsoft Windows® and 
Pocket PC versions of ActiveSync. You must install the Windows version of 
ActiveSync on your computer using the Dell™ Companion CD. The Pocket 
PC version is already installed on your device.

 NOTE: Before connecting your device to a computer for the first time, ensure 

that you install ActiveSync on the computer from the Dell™ Companion CD.
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Installing and Using ActiveSync
To install ActiveSync:

1 Insert the Dell Companion CD.

2 Click Getting Started to access the main menu.

3 Click Start Here.

4 Click Install ActiveSync and follow the instructions on the screen.

After the installation is complete, the ActiveSync Setup Wizard helps you to 
connect your device to your computer, set up a partnership so that you can 
synchronize information between your device and your computer, and 
customize your synchronization settings. Your first synchronization process 
automatically begins when you complete the wizard. 

 NOTE: The device must be powered on for the synchronization process to 

occur. 

During your first synchronization, information that was stored in Outlook 
on your computer is copied to Calendar, Contacts, and Tasks on your device.

After you set up ActiveSync and complete the first synchronization process, 
you can initiate synchronization from your device. To switch to ActiveSync 
on your device, tap the Start button and tap ActiveSync. If you have a 
wireless LAN card, you can synchronize remotely from your device.

To find information on using ActiveSync on your device, open ActiveSync 
on your device, tap the Start button, and then tap Help.

To find information on using ActiveSync on your computer, open 
ActiveSync on your computer, and click Help→ Microsoft ActiveSync Help.
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Scheduling and Communicating

About Microsoft® Pocket Outlook

Calendar

Contacts

Tasks

Notes

Messaging 

Notifications
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About Microsoft® Pocket Outlook
Pocket Outlook includes Calendar, Contacts, Tasks, Messaging, and Notes. 
You can use these programs individually or together. For example, e-mail 
addresses stored in Contacts can be used to address e-mail messages in 
Messaging.

Using Microsoft ActiveSync®, you can synchronize information in Microsoft 
Outlook or Microsoft Exchange on your computer with your device. You can 
also synchronize this information directly with an Exchange server. Each 
time you synchronize, ActiveSync compares the changes you made on your 
device and computer or server and updates both computers with the latest 
information. For information on using ActiveSync, see ActiveSync Help on 
your computer.

You can switch to any of the following programs through the Start menu.

Calendar
Use Calendar to schedule appointments, including meetings and other 
events. You can check your appointments in one of several views (Agenda, 
Day, Week, Month, and Year) and easily switch views by using the view 
menu. Tap the today icon to view the current date.
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 NOTE: To customize Calendar, such as changing the first day of the week, tap 

Tools and tap Options. 

To create an appointment:

1 In the Day or Week view, tap the desired date and time for the 
appointment.

2 Tap New.

3 Tap a field to select it, and enter a description and a location using the 
input panel.

4 If necessary, tap the date and time to change them.

5 To see all available fields, tap the input panel icon to hide it. Enter the 
remaining information, if necessary.

today icon

view menu input panel icon
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64 Scheduling and Communicating

6 To add notes, tap the Notes tab. 

You can enter text, draw, or create a recording. For more information on 
creating notes, see "Notes" on page 68.

7 When you have finished entering information, tap OK to return to the 
calendar. 

To receive a notification for an appointment, select Remind me in the 
appointment settings. You can configure notifications through the Sounds & 
Notifications icon. For more information, see "Notifications" on page 74.

Using the Summary Screen

When you tap an appointment in Calendar, a summary screen displays. To 
change the appointment, tap Edit.

Creating Meeting Requests

You can use Calendar to set up meetings with users of Outlook or Pocket 
Outlook. The meeting request is automatically created when you 
synchronize Messaging or when you connect to your e-mail server. To set 
how you want meeting requests sent, tap Tools and tap Options. If you send 
and receive e-mail messages through ActiveSync, select ActiveSync.

To schedule a meeting:

1 Create an appointment.

2 On the Appointment tab, tap the input panel to hide it, and then tap 
Attendees.

The Attendees field lists the e-mail addresses that you have entered in 
Contacts.

3 Select the meeting attendees. 

The meeting notice is created automatically and placed in the Outbox 
folder.

For more information on sending and receiving meeting requests, tap the 
Start button, tap Help, and then tap Calendar or Messaging.
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Contacts
Use Contacts to maintain a list of your friends and colleagues. You can 
quickly share Contacts information with other device users using the 
infrared port.

 NOTE: To change the way information is displayed in the list, tap Tools and tap 

Options.

To create a contact:

1 Tap the Start button and tap Contacts.

2 Tap New.

3 Using the input panel, enter a name and other contact information. 
Scroll down to see all available fields.

search field

category
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66 Scheduling and Communicating

4 To assign the contact to a category, tap Categories and select a category 
from the list. 

In the contact list, you can display contacts by category.

5 To add notes, tap the Notes tab. You can enter text, draw, or create a 
recording. For more information on creating notes, see "Notes" on 
page 68.

6 When you have finished entering information, tap OK to return to the 
calendar. 

Finding a Contact

You can find a contact using one of the following methods: 

• In Contacts, enter a contact name in the field under the navigation bar. 
To show all contacts, clear text from the box or tap the arrow to the 
right of the box. 

• In Contacts, tap the category list (labeled All Contacts by default) and 
select a category. To show all contacts again, tap All Contacts. To view 
a contact not assigned to a category, select None. 

• To view the names of companies your contacts work for, tap View in 
the contact list and tap By Company. The number of contacts that 
work for that company is displayed to the right of the company name. 

• Tap the Start button, tap Find, and then enter the contact name. In 
the Type drop-down menu, tap Contacts, and then tap Go. 

Using the Summary Screen

When you tap a contact in the contact list, a summary screen is displayed. 
To change the contact information, tap Edit.

Tasks
 NOTE: To change the way information is displayed in the list, tap Tools and tap 

Options.

Use Tasks to keep a list of things that you need to do.
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To create a task:

1 Tap the Start button and tap Tasks.

2 Tap New.

3 Enter a description using the input panel.

4 If necessary, enter a start date and due date or other information by 
first tapping the field. Tap the input panel icon to hide it to see all 
available fields.

5 To assign the task to a category, tap Categories and select a category 
from the list. In the task list, you can display tasks by category.

6 To add notes, tap the Notes tab. You can enter text, draw, or create a 
recording. For more information on creating notes, see "Notes" on 
page 68.

sort menu
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68 Scheduling and Communicating

7 When you have finished entering information, tap OK to return to the 
calendar. 

 NOTE: To quickly create a task with only a subject, tap Tools and tap Entry Bar. 

Tap Tap here to add a new task, and enter your task information.

Notes
Quickly capture thoughts, reminders, ideas, drawings, and phone numbers 
with Notes. You can create a written note or a recording. You can also include 
a recording in a note. If a note is open when you create the recording, it is 
included in the note as an icon. If a note is not open, the recording is saved 
as a stand-alone recording.

record icon

pen icon

input panel icon
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To create a note:

1 Tap the Start menu, tap Programs, and then tap Notes.

2 Tap New.

3 Create your note by writing, drawing, typing, or recording. For more 
information on using the input panel, writing and drawing on the 
screen, and creating recordings, see "Entering Information" on page 41.

Messaging
Use Messaging to send and receive e-mail messages: 

• Synchronize e-mail messages using Exchange or Outlook on your 
computer.

• Send and receive e-mail messages by connecting directly to an e-mail 
server through an ISP or a network.

Synchronizing E-Mail Messages

You can synchronize e-mail messages along with the rest of your data if you 
enable Messaging synchronization in ActiveSync. For information on 
enabling Messaging synchronization, see ActiveSync Help on your computer.

 NOTE: You can also synchronize e-mail messages with your computer from a 

remote location. For more information, see "Getting Connected" on page 95.

During synchronization:

• Messages are copied from the e-mail folders of Exchange or Outlook on 
your computer to the ActiveSync folder in Messaging on your device. 
By default, you receive:

– Messages from the past 3 days

– The first 100 lines of each message

– File attachments of less than 100 KB in size

• E-mail messages in the Outbox folder on your device are transferred to 
Exchange or Outlook on your computer, and then sent from those 
programs.

• E-mail messages in subfolders on your computer must be selected in 
ActiveSync to be transferred.
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70 Scheduling and Communicating

Connecting Directly to an E-Mail Server

In addition to synchronizing e-mail messages with your computer, you can 
send and receive e-mail messages by connecting to an e-mail server using a 
modem or network card connected to your device. You need to set up a 
remote connection to a network or an ISP, and a connection to your e-mail 
server. For more information, see "Getting Connected" on page 95.

When you connect to the e-mail server:

• New messages are downloaded to the device Inbox folder.

• Messages in the device Outbox folder are sent.

• Messages that have been deleted on the e-mail server are removed from 
the device Inbox folder.

Messages that you receive directly from an e-mail server are linked to your 
e-mail server rather than to your computer. When you delete a message on 
your device, it is also deleted from the e-mail server the next time you 
connect depending on the settings you selected in ActiveSync.

When you are working online, you read and respond to messages while 
connected to the e-mail server. Messages are sent as soon as you tap Send, 
which saves space on your device.

After you have downloaded new message headers or partial messages, you 
can disconnect from the e-mail server and then decide which messages to 
download completely. The next time you connect, Messaging downloads the 
messages you have marked for retrieval and sends the messages you have 
composed.

Using the Message List

Messages you receive are displayed in the message list. By default, the most 
recently received messages are displayed first in the list.

When you receive a message, tap to open it. Unread messages are displayed 
in bold.
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When you connect to your e-mail server or synchronize with your computer, 
you receive by default:

• Messages from the last 5 days

• The first 100 lines of each new message

• File attachments of less than 100 KB in size

The original messages remain on the e-mail server or your computer. You can 
mark the messages that you want to retrieve in full during your next 
synchronization or e-mail server connection. In the message list, tap and 
hold the message that you want to retrieve. On the pop-up menu, tap Mark 
for Download. The icons in the Inbox message list indicate message status.

delete icon

forward icon

previous/next message
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72 Scheduling and Communicating

You specify your downloading preferences when you set up the service or 
select your synchronization options. You can change the settings at any time:

• Change options for Messaging synchronization using ActiveSync 
options. For more information, see ActiveSync Help on your computer.

• Change options for direct e-mail server connections in Messaging on 
your device. Tap Tools and tap Options. On the Account tab, tap the 
service that you want to change. Tap and hold the service and select 
Delete to remove a service.

Composing Messages

To compose a message:

1 Tap the Start button and tap Messaging.

2 Tap New. 

Contacts icon

record icon
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3 In the To field, enter an e-mail of one or more recipients, separating 
them with a semicolon. Or tap the Contacts icon to select names from 
the contact list.

 NOTE: All e-mail addresses entered in the e-mail fields in Contacts appear in 

the Address Book.

4 Compose your message. To enter preset or frequently used messages, 
tap My Text and select a message.

5 Tap Send when you have finished the message. 

If you are working offline, the message is moved to the Outbox folder 
and sent the next time you connect.

Managing E-Mail Messages and Folders

By default, messages are displayed in one of five folders for each service you 
have created: Inbox, Deleted Items, Drafts, Outbox, or Sent Items. The 
Deleted Items folder contains messages that have been deleted on the 
device. The behavior of the Deleted Items and Sent Items folders depends 
on the options you have selected.To change the options, tap Tools in the 
message list and tap Options. On the Message tab, select your options.

To create a new folder, tap Tools, and tap Manage Folders. To move a 
message to another folder, tap and hold the message in the message list and 
tap Move to on the pop-up menu.

Folder Behavior With a Direct Connection to an E-Mail Server

The behavior of the folders you create depends on whether you use 
ActiveSync, POP3, or IMAP4. 

• If you use ActiveSync, e-mail messages in the Inbox folder in Outlook 
are automatically synchronized with your device. You can select to 
synchronize additional folders by designating them for ActiveSync. 
The folders you create and the messages you move are then mirrored 
on the server. For example, if you move messages from the Inbox folder 
to a folder named Family, and you have designated Family for 
synchronization, the server creates a copy of the Family folder and 
copies the messages into that folder. You can then read the messages 
while away from your computer.
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74 Scheduling and Communicating

• If you use POP3 and you move e-mail messages to a folder you created, 
the link is broken between the messages on the device and their copies 
on the e-mail server. The next time you connect, the e-mail server 
detects that the messages are missing from the device Inbox and 
deletes them from the server. This prevents you from having duplicate 
copies of a message. However, you no longer have access to messages 
that you move to folders created from anywhere except the device. 

• If you use IMAP4, the folders you create and the e-mail messages you 
move are mirrored on the server. Therefore, messages are available to 
you any time you connect to your e-mail server, whether it is from your 
device or computer. This synchronization of folders occurs whenever 
you connect to the server, create new folders, or rename/delete folders 
when connected. 

Notifications
You can set your device to remind you when you have something to do. For 
example, if you have set up an appointment in Calendar, a task with a due 
date in Tasks, or an alarm in Clock, you are notified in one of the following 
ways:

• A message box appears on the screen.

• A sound, which you can specify, is played.

• A light flashes on your device. 

To configure the reminders and sounds for your device:

1 Tap the Start button and tap Settings. 

2 On the Personal tab, tap Sounds & Notifications. 

• Sounds tab — Adjust the volume and enable sounds.

• Notifications tab — Set notifications for specific events.
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Adding Programs Using Microsoft® ActiveSync®

Downloading Programs From the Internet

Adding a Program to the Start Menu

Removing Programs
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Programs that were already installed when you received your device are 
stored in ROM. You cannot remove these programs, and you never 
accidentally lose ROM contents. ROM programs can be updated using 
installation programs with the *.xip extension. You can save data to either 
ROM or RAM. 

You can install any program created for your device as long as your device has 
sufficient memory. The most popular place to find software for your device is 
on the Microsoft® Windows Mobile™ 2003 Second Edition website: 
www.microsoft.com/windowsmobile.

Adding Programs Using Microsoft® 
ActiveSync®

You need to install the appropriate software for your device on your 
computer before installing software on your device. See "Using Microsoft® 
ActiveSync®" on page 57 for more information.

1 Determine your device and processor type so that you know which 
version of the software to install:

a Tap the Start button and tap Settings. 

b On the System tab, tap About. 

c From the Version tab, record the processor information. 

2 Download the software to your computer (or insert the CD or floppy 
disk that contains the software into your computer). You may see a 
single *.xip, *.exe, or *.zip file, a Setup.exe file, or several versions of 
files for different device types and processors. Ensure that you select 
the program designed for the Pocket PC and your device processor 
type.

3 Read any installation instructions, readme files, or documentation that 
comes with the program. Many programs provide special installation 
instructions.

4 Connect your device to your computer.

5 Double-click the *.exe file.

If the file is an installer file, the installation wizard begins. Follow the 
directions on the screen. Once the software has been installed on your 
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computer, the installer automatically transfers the software to your 
device. 

If the file is not an installer file, you receive an error message stating 
that the program is valid but that it is designed for a different type of 
computer. You need to move this file to your device. If you cannot find 
any installation instructions for the program in the readme file or 
documentation, use ActiveSync Explore to copy the program file to the 
Program Files folder on your device. For more information on copying 
files using ActiveSync, see ActiveSync Help on your computer. 

To open a program after the installation is complete, tap the Start button, 
tap Programs, and then tap the program icon.

Downloading Programs From the Internet
1 Determine your device and processor type so that you know which 

version of the software to install:

a Tap the Start button and tap Settings. 

b On the System tab, tap About. 

c From the Version tab, record the processor information. 

2 Using Pocket Internet Explorer, download the program to your device. 
You may see a single *.xip, *.exe or *.zip file, a Setup.exe file, or several 
versions of files for different device types and processors. Ensure that 
you select the program designed for the Pocket PC and your device 
processor type.

3 Read any installation instructions, readme files, or documentation that 
comes with the program. Many programs provide special installation 
instructions.

4 Tap the file, such as a *.xip or *.exe file. 

The installation wizard begins. Follow the directions on the screen.
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Adding a Program to the Start Menu
1 Tap the Start button and tap Settings.

2 Tap Menus, tap the Start Menu tab, and then tap the check box for 
the program.

If the program is not listed, you can either use File Explorer on the 
device to move the program to the Start Menu folder, or use 
ActiveSync on the computer to create a shortcut to the program and 
place the shortcut in the Start Menu folder.

Using File Explorer on the Device

1 Tap the Start button, tap Programs, and tap File Explorer.

2 Locate the program. Tap the folder list (labeled My Documents by 
default) and then tap My Device to see a list of all folders on the 
device. 

3 Tap and hold the program name and tap Cut on the pop-up menu. 

4 Open the Start Menu folder located in the Windows® folder.

5 Tap and hold a blank area of the window, and tap Paste on the pop-up 
menu. 

The program now appears on the Start menu. For more information on 
using File Explorer, see "Finding and Organizing Information" on page 39.

Using ActiveSync on the Computer

Use Explorer in ActiveSync to explore your device files and locate the 
program. Right-click the program and click Create Shortcut. Move the 
shortcut to the Start Menu folder in the Windows folder. The shortcut now 
appears on the Start menu. For more information, see ActiveSync Help on 
your computer.
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Removing Programs
1 Tap the Start button and tap Settings. 

2 Tap the System tab and tap Remove Programs.

If the program does not appear in the list of installed programs, use File 
Explorer on your device to locate the program.

3 Tap and hold the name of the program, and tap Delete on the pop-up 
menu.
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Using Companion Programs

Microsoft® Pocket Word

Pocket Excel

MSN Messenger

Windows Media® Player for Pocket PC
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82 Using Companion Programs

The companion programs include Microsoft Pocket Word, Microsoft Pocket 
Excel, Microsoft Money, Windows Media Player for Pocket PC, and 
Microsoft Reader. 

To switch to a companion program on your device, tap the Start button, tap 
Programs, and then tap the program name.

Microsoft® Pocket Word
Pocket Word works with Microsoft Word on your computer to give you easy 
access to copies of your documents. You can create new documents on your 
device, or you can copy documents from your computer to your device. 
Synchronize documents between your computer and your device so that you 
have the most up-to-date content in both locations.

Use Pocket Word to create documents, such as letters, meeting minutes, and 
travel reports. To create a new file:

1 Tap the Start button→ Programs→ Pocket Word.

2 Tap New. 

A blank document appears. Or, if you selected a template for new 
documents in the Options dialog box, the template appears with 
appropriate text and formatting already provided. 
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You can open only one document at a time. If you open a second document, 
you are asked to save the first one. You can create, save, or edit a document 
in a variety of formats, including Word (.doc), Pocket Word (.psw), Rich 
Text Format (.rtf), and Plain Text (.txt). 

Pocket Word contains a list of the files stored on your device. Tap a file in 
the list to open it. To delete, make copies of, or send files, tap and hold a file 
in the list. Then select the appropriate action in the pop-up menu.

You can enter information in Pocket Word in one of four modes: typing, 
writing, drawing, or recording. These modes are displayed on the View 
menu. Each mode has its own toolbar, which you can show and hide by 
tapping the Show/Hide Toolbar icon on the command bar.

formatting 

toolbar

show/hide 

formatting toolbar
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To change the zoom magnification, tap View, tap Zoom, and then select the 
percentage that you want. Select a higher percentage to enter text and a 
lower percentage to see more of your document.

If you are opening a Word document created on a computer, select Wrap to 
Window on the View menu so that you can see the entire document.

Pocket Excel
Pocket Excel works with Microsoft Excel on your computer to give you easy 
access to copies of your workbooks. You can create new workbooks on your 
device, or you can copy workbooks from your computer to your device. 
Synchronize workbooks between your computer and your device so that you 
have the most up-to-date content in both locations.

Use Pocket Excel to create workbooks, such as expense reports and mileage 
logs. To create a new file:

1 Tap the Start button→ Programs→ Pocket Excel.

2 Tap New. 

A blank workbook appears. Or, if you selected a template for new 
workbooks in the Options dialog box, the template appears with 
appropriate text and formatting already provided. 
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You can open only one workbook at a time. If you open a second workbook, 
you are asked to save the first one. You can create, save, or edit a workbook in 
a variety of formats, including Pocket Excel (.pxl) and Excel (.xls).

Pocket Excel contains a list of the files stored on your device. Tap a file in the 
list to open it. To delete, make copies of, or send files, tap and hold a file in 
the list. Then select the appropriate action from the pop-up menu.

Pocket Excel provides fundamental spreadsheet tools, such as formulas, 
functions, sorting, and filtering. To display the toolbar, tap View and tap 
Toolbar. 

show/hide 

formatting toolbar

formatting 

toolbar
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If your workbook contains sensitive information, you can protect it with a 
password. To set a password, open the workbook, tap Edit, and then tap 
Password. Every time you open the workbook, you need to enter the 
password, so choose one that is easy for you to remember but difficult for 
others to guess.

Tips for Working in Pocket Excel

Use the following tips when working in large worksheets in Pocket Excel:

• Tap View and tap Full Screen to see as much of your worksheet as 
possible. To exit full-screen mode, tap Restore.

• Show and hide window elements. Tap View and then tap the elements 
that you want to show or hide.

• Freeze panes on a worksheet. First select the cell where you want to 
freeze panes. Tap View and tap Freeze Panes. You might want to freeze 
the top and leftmost panes in a worksheet to keep row and column 
labels visible as you scroll through a sheet.

• Split panes to view different areas of a large worksheet. Tap View and 
tap Split. Drag the split bar to where you want it. To remove the split, 
tap View and tap Remove Split.

• Show and hide rows and columns. To hide a row or column, select a cell 
in the row or column you want to hide. Tap Format, tap Row or 
Column, and then tap Hide. To show a hidden row or column, tap 
Tools, tap Go To, and then type a reference that is in the hidden row or 
column. Then tap Format, tap Row or Column, and then tap Unhide.

For more information on using Pocket Excel, tap the Start button and tap 
Help.

MSN Messenger
With the MSN Messenger instant message program, you can:

• See who is online.

• Send and receive instant messages.

• Have instant message conversations with groups of contacts.
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To use MSN Messenger, you must have a Microsoft Passport account or a 
Microsoft Exchange e-mail account. You must have a Passport to use MSN 
Messenger Service. If you have a Hotmail or MSN account, you already have 
a Passport. Once you have obtained either a Microsoft Passport or a 
Microsoft Exchange account, you are ready to set up your account.

 NOTE: Sign up for a Microsoft Passport account at www.passport.com. Get a 

free Microsoft Hotmail e-mail address at www.hotmail.com.

To switch to MSN Messenger, tap the Start button→ Programs→ MSN 
Messenger.

Setting Up 

Before you can connect, you must enter Passport or Exchange account 
information.

To set up an account and sign in:

1 Tap the Start button→ Programs→ MSN Messenger.

2 Tap Tools and tap Options.

3 On the Accounts tab, enter your Passport or Exchange account 
information.

4 To sign in, tap the sign-in screen and enter your e-mail address and 
password.

Working With Contacts

The MSN Messenger window shows all of your messenger contacts at a 
glance, divided into Online and Not Online categories. From this view, 
while connected, you can chat, send an e-mail, block the contact from 
chatting with you, or delete contacts from your list using the pop-up menu.

 NOTE: If you already use MSN Messenger on your computer, your contacts 

show up on your device without having to be added.

To see others online without them seeing you, tap Tools→ My Status→ 
Appear Offline.

If you block a contact, you appear offline but remain on the blocked 
contact's list. To unblock a contact, tap and hold the contact, and then tap 
Unblock on the pop-up menu.
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Chatting With Contacts

• Tap a contact name to open a chat window. Enter your message in the 
text entry area at the bottom of the screen or tap My Text to enter a 
preset message, and then tap Send. 

• To invite another contact to a multiuser chat, tap Tools, tap Invite, and 
then tap the contact you want to invite.

• To switch back to the main window without closing a chat, tap the 
Contacts icon. To revert back to your chat window, tap Chats, and 
select the person with whom you were chatting.

• To know if the contact you are chatting with is responding, look for the 
message under the text entry area.

For more information on using MSN Messenger, tap the Start button and 
tap Help.

Windows Media® Player for Pocket PC
Use Windows Media Player for Pocket PC to play digital audio and video 
files that are stored on your device or on a network. To switch to Windows 
Media Player for Pocket PC, tap the Start button→ Programs→ Windows 
Media.

Use Windows Media Player on your computer to copy digital audio and 
video files to your Pocket PC. You can play Windows Media and MP3 files 
on your Pocket PC.

For more information about using Windows Media Player for Pocket PC, tap 
the Start button and tap Help.
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90 Using Microsoft® Pocket Internet Explorer

Use Pocket Internet Explorer to view Web or WAP pages:

• During synchronization with your computer, download your favorite 
links and mobile favorites that are stored in the Mobile Favorites 
subfolder in Internet Explorer on your computer.

• Connect to an Internet service provider (ISP) or network and browse 
the Web. For more information on connecting to the Internet, see 
"Getting Connected" on page 95.

When the device is connected to an ISP or network, you can also download 
files and programs from the Internet or intranet.

To switch to Pocket Internet Explorer, tap the Start button and tap Internet 
Explorer.

Mobile Favorites
If you are using Microsoft Internet Explorer 5.0 or later on your computer, 
you can download mobile favorites to your device. Synchronizing mobile 
favorites downloads Web content to your device so that you can view pages 
while you are disconnected from your ISP and computer. Use the Internet 
Explorer plug-in installed with Microsoft ActiveSync® to create mobile 
favorites quickly.

To create a mobile favorite on your computer and download it to your 
device:

1 On your computer, open Internet Explorer and click Tools→ Create 
Mobile Favorite.

2 To change the link name, enter a new name in the Name box.

3 Specify an update schedule next to Update (optional).

4 Click OK. 

Internet Explorer downloads the latest version of the page to your 
computer.

5 In Internet Explorer on the computer, right-click the mobile favorite 
and click Properties. 

6 On the Download tab, specify the number of levels deep you want to 
download. To conserve device memory, go only one level deep.
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7 Synchronize your device and computer. 

Mobile favorites that are stored in the Mobile Favorites folder in 
Internet Explorer are downloaded to your device.

If you did not specify an update schedule in step 3, you need to manually 
download content to keep the information updated on your computer and 
device. Before synchronizing with your device, click Tools in Internet 
Explorer on your computer and click Synchronize. The date in the Last 
Updated column was the last time content was downloaded to the 
computer. You can manually download content, if necessary.

 NOTE: You can add an icon to the Internet Explorer toolbar for creating mobile 

favorites. In Internet Explorer on your computer, click View→Toolbars, and then 

click Customize.

Conserving Memory

Mobile favorites take up storage memory on your device. To minimize the 
amount of memory used:

• Turn off pictures and sounds or stop some mobile favorites from being 
downloaded to the device in the Favorites settings in the ActiveSync 
options. For more information, see ActiveSync Help on your computer.

• Limit the number of downloaded linked pages. In Internet Explorer on 
the computer, right-click the mobile favorite you want to change and 
click Properties. On the Download tab, specify 0 or 1 for the number 
of linked pages you want to download.

Mobile Favorites Folder

Only items stored in the Mobile Favorites subfolder (in the Favorites folder) 
in Internet Explorer on your computer are synchronized with your device. 
The folder was created automatically when you installed ActiveSync.

Favorite Links

During synchronization, the list of favorites in the Mobile Favorites folder 
on your computer is synchronized with Pocket Internet Explorer on your 
device. The computer and the device are updated with changes made to 
either list each time you synchronize. Unless you mark the favorite link as a 
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92 Using Microsoft® Pocket Internet Explorer

mobile favorite, only the link is downloaded to your device—you need to 
connect to your ISP or network to view the content. For more information 
on synchronization, see ActiveSync Help on your computer.

Using AvantGo Channels
AvantGo is a free interactive service that gives you access to personalized 
content and thousands of popular websites. You subscribe to AvantGo 
channels directly from your device. Then synchronize your device and 
computer, or connect to the Internet to download the content. For more 
information, see the AvantGo website.

To sign up for AvantGo: 

1 In ActiveSync options on your computer, turn on synchronization for 
the AvantGo information type.

2 In Pocket Internet Explorer on your device, tap Favorites to display 
your list of favorites.

3 Tap the AvantGo Channels link.

4 Tap Activate.

5 Follow the directions on the screen. 

You need to synchronize your device with your computer and then tap 
the My Channels to complete the AvantGo setup.

When synchronization is complete, tap the AvantGo Channels link in your 
list of favorites to see a few of the most popular channels. To add or remove 
channels, tap the Add or Remove link.

Browsing Mobile Favorites and the Web
You can use Pocket Internet Explorer to browse mobile favorites and 
channels that you have downloaded to your device without connecting to 
the Internet. You can also connect to the Internet through an ISP or a 
network connection and browse the Web.
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To view mobile favorites and channels:

1 Tap the favorites icon to display your list of favorites. 

2 Tap the page you want to view. 

The page that was downloaded the last time you synchronized with your 
computer appears. If the page is not on your device, the favorite is dimmed. 
You need to synchronize with your computer again to download the page to 
your device, or connect to the Internet to view the page.

To browse the Internet, set up a connection to your ISP or corporate network 
using Connections, as described in "Getting Connected" on page 95.

 NOTE: To add a favorite link, go to the page that you want to add, tap and hold 

the page, and then tap Add to Favorites.

favorites icon

home icon

refresh icon

back icon
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94 Using Microsoft® Pocket Internet Explorer

To connect to and browse the Internet:

• Tap the favorites icon and tap the favorite you want to view.

• Tap View and tap Address Bar. In the address bar that appears at the 
top of the screen, enter the Web address that you want to see and tap 
Go. Tap the arrow to select previously entered addresses.
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You can use your device to exchange information with other mobile devices 
or with a computer, a network, or the Internet. You can use any of the 
following connection options:

• Use the infrared (IR) port on your device to send and receive files 
between two devices. See the following section, "Using Infrared," for 
more information.

• Connect to your Internet service provider (ISP). Once you are 
connected, you can send and receive e-mail messages by using 
Messaging, and view Web or WAP pages by using Microsoft® Pocket 
Internet Explorer. The communication software for creating an ISP 
connection is already installed on your device. Your service provider 
provides software needed to install other services, such as paging and 
fax services.

• Connect to the network at your company or organization where you 
work. Once you are connected, you can send and receive e-mail 
messages by using Messaging, view Web or WAP pages by using Pocket 
Internet Explorer, and synchronize with your computer. 

• Connect to your computer to synchronize remotely. Once you are 
connected, you can synchronize information such as your Pocket 
Outlook information. See Microsoft ActiveSync® Help on your 
computer or Connections Help on the device for more information.

Using Infrared
Using infrared, you can send and receive information, such as contacts and 
appointments, between two devices.

To send information:

1 Switch to the program where you created the item you want to send 
and locate the item in the list.

2 Align the infrared sensors so that they are unobstructed and within a 
close range.

3 Tap and hold the item, and tap Beam xxxx on the pop-up menu, where 
xxxx is the item that you want to beam.

You can also send items (excluding folders) from File Explorer. Tap and hold 
the item you want to send, and tap Beam File on the pop-up menu.
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Using Bluetooth
To configure a Bluetooth device in a Pocket PC environment:

1 From the lower-right corner of the Today screen, tap the Bluetooth 
icon, .

2 From the pop-up menu, select Bluetooth Manager.

3 To establish a Bluetooth connection, tap New.

4 Tap Explore a Bluetooth device.

5 Tap the remote Bluetooth device that you want to connect.

6 Tap the service that you want to use to create the connection.

7 Tap Finish to create the connection.

8 Tap and hold the connection created under My Shortcuts and tap 
Connect.

9 If the device to which you are trying to connect prompts you for a 
Passkey, enter the Passkey and tap OK.

 NOTE: You need to get the passkey from the remote Bluetooth device.

An active Bluetooth connection is created and is ready to use.

 NOTE: For more information about using Bluetooth, tap the Start button→ 

Help→ Bluetooth to access the Microsoft Help on your device.

Using Wi-Fi (802.11b)
To configure the Wireless Network in a PocketPC environment:

1 Press the wireless button to enable the wireless capability on your 
device.

2 Tap the Start button→ Settings→ Connections tab.
3 To add, edit, or delete a profile, tap Network Cards.

4 On the Configure Wireless Networks screen, select one of the available 
network names. 

 NOTE: If the network name is not listed, you must add a configuration profile 

for each wireless network environment in which you want to use your (mobile) 

wireless client station. If you plan to use your wireless client station in multiple 

networking environments that require different configuration settings, you can 
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define dedicated profiles for each environment. For example, you can create a 

configuration profile for your office headquarters, a branch office, and your 

home or SOHO network. 

a If there are none listed then tap Add New Settings... Type in the 
network name. If this will be Peer-to-Peer connection tap the "This 
is a device to computer (ad-hoc) connection" check box.

b Tap the Authentication tab if your connection does not require 
encryption. 

• To disable WEP, tap the Data encryption (WEP enabled) check 
box.

• If you are using Network Authentication (Shared mode), tap the 
check box.

• Tap the The key is provided for me automatically check box.

• If you do require encryption and are provided with the key 
automatically, the The key is provided for me automatically check 
box, when selected, allows you to enter the encryption key yourself. 
You can enter key values in either Alphanumeric Value or 
Hexadecimal Value. The encryption key value is case-sensitive. 
Consult your LAN Administrator for the correct value. 

If you are using IEEE 802.1x option you will first need to get a certificate 
through a non 802.1x enabled wireless network connected to a certificate 
server. Select or configure a non 802.1x enabled wireless network from the 
list. 

Creating a Modem Connection
1 Obtain the following information from your ISP: 

– ISP dial-up access telephone number

– Username and password

– TCP/IP settings

Some ISPs require information in front of the username, such as 
MSN/username.

2 Install a modem card, or use a null modem cable and appropriate 
adapters to connect an external modem to your device through the 
serial port.
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3 Tap the Start button→ Settings→ Connections tab→ Connections.

4 Under My ISP or My Work Network, tap Add a new modem 
connection.

5 Enter a name for the connection, such as ISP Connection.

6 From the Select a modem list, select your modem type, and tap Next.

If your modem type does not appear, try reinserting the modem card. If 
you are using an external modem that is connected to your device with 
a cable, select Hayes Compatible on COM1.

7 Enter the access phone number and tap Next.

8 Enter your user name, password, and, if applicable, your domain.

 NOTE: You should not need to change any settings in Advanced. Most ISPs 

now use a dynamically assigned address.

9 If the ISP you are connecting to does not use a dynamically assigned 
address, tap Advanced, tap the TCP/IP tab, and then enter the 
address. 

10 Tap Next.

11 Select other appropriate options and tap Finish.

When you open Messaging, Pocket Internet Explorer, or MSN Messenger, 
your device automatically connects. Once you are connected, you can:

• Send and receive e-mail messages using Messaging. Before you can use 
Messaging, you need to provide the information Messaging needs to 
communicate with the e-mail server. See "Connecting Directly to an E-
Mail Server" on page 102 for more information.

• See Web and WAP pages using Pocket Internet Explorer. For more 
information, see "Using Microsoft® Pocket Internet Explorer" on 
page 89.

• Send and receive instant messages with MSN Messenger. For more 
information, see "MSN Messenger" on page 86.

Creating an Ethernet Connection
1 Install the network card driver, if required. 

See the documentation that came with your network card.
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2 Insert the network card into your device.

• If a network with a broadcast SSID is detected, the wireless 

network icon, , and the New Network Detected bubble 

appear in the navigation bar. Go to step 3.

• If a network with a broadcast SSID is not detected, skip to step 4.

3 Tap The Internet or Work, depending to which type of network you are 
connecting. Your device automatically connects to the network.

 NOTE: If multiple networks are detected, tap the network to which you want to 

connect, tap The Internet or Work, and tap Connect.

4 Tap the Start button→ Settings→ Connections tab→ Connections.

5 Tap the Wireless Ethernet icon.

6 On the Wireless tab, tap New Settings.

7 Enter the SSID next to Network Name, and select whether the 
network connects to the Internet or work.

8 Tap the Authentication tab to enable or disable WEP settings, 
depending on your network type.

9 Tap OK.

When your device successfully connects to the network, your 
connection status appears under Wireless Networks.

Creating a VPN Connection
1 Tap the Start button→ Settings→ Connections tab→ Connections.

2 Tap Add a new VPN server connection.

3 Enter a name for the connection, such as your company's name.

4 In the Host name/IP field, enter the VPN server name or IP address.

5 Next to VPN type, tap IPSec or PPTP, depending on the type of 
authentication that you want to use with your device. 

If you are unsure about which option to select, ask your network 
administrator.

6 Tap Next.

7 Enter your username, password, and, if required, domain.
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8 Install the network card driver, if required. 

See the documentation that came with your network card.

9 Insert the network card into your device.

• If a network with a broadcast SSID is detected, the wireless 

network icon, , and the New Network Detected bubble 

appear in the navigation bar. Go to step 10.

• If a network with a broadcast SSID is not detected, skip to step 11.

10 Tap The Internet.

 NOTE: If multiple networks are detected, tap the network to which you want to 

connect, tap The Internet, and tap Connect.

11 Tap the Start button→ Settings→ Connections tab→ Connections.

12 Tap the Wireless Ethernet icon.

13 On the Wireless tab, tap New Settings.

14 Enter the SSID next to Network Name, and tap The Internet.

15 Tap the Authentication tab to enable or disable WEP settings, 
depending on your network type.

16 Tap OK.

17 Tap the connection icon, , that appears in the navigation bar.

18 Tap the name of your VPN connection to enable it.

Ending a Connection
To disconnect:

• When connected through dial-up or VPN, tap the Connection icon on 
your navigation bar and tap End. 

• When connected through a cable or cradle, detach your device from 
the cable or cradle. 

• When connected through the infrared sensor, move the device away 
from the computer. 

• When connected through a network (Ethernet) card, remove the card 
from your device. 
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Connecting Directly to an E-Mail Server
You can set up a connection to an e-mail server so that you can send and 
receive e-mail messages by using a modem or network connection and 
Messaging on your device.

 NOTE: The ISP or network must use a POP3 or IMAP4 e-mail server and an 

SMTP gateway.

You can use multiple e-mail services to receive your messages. For each 
e-mail service you intend to use, you must first set up and name the 
e-mail service. If you use the same service to connect to different mailboxes, 
set up and name each mailbox connection.

To set up an e-mail service:

1 In Messaging on your device, tap Accounts and tap New Account. 

2 Follow the directions in the E-mail Setup wizard.

For more information, tap the Start button and tap Help. 

To connect to your e-mail server, tap Account and tap Connect. For more 
information on using the Messaging program, see "Messaging" on page 69.

Getting Help on Connecting
For more information on getting connected, see the following resources:

• "Messaging" on page 69.

• Online Help on the device. Tap the Start button and tap Help. Tap 
Messaging or Connections.

• ActiveSync Help on your computer. In ActiveSync, click Help and click 
Microsoft ActiveSync Help.

• See www.microsoft.com/windowsmobile for troubleshooting 
information.
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Specifications

System Information

Processor Intel® XScale™ PXA270 processor at 
up to 624 MHz

Memory

RAM 64- or 32-MB SDRAM

ROM 64- or 32-MB Intel® StrataFlash™ ROM

Operating System Microsoft® Windows Mobile™ 2003 
Second Edition

Display

Type QVGA TFT Color 16-bit, touch-
sensitive transflective display

Size 3.5 inches 

Resolution 240 x 320 at 65,536 colors

LCD brightness 100 nits

Controls and Lights

Navigation 5-way navigation button

Scroll Dial up, down, action

Buttons: four program buttons: Calendar, 
Contacts, Messaging, Home

power on/off

wireless/Microsoft Windows Media® 
Player on/off

voice record button

reset button

Lights: synchronization/communication

event notification

charge status



Appendix 105

Expansion Slots

Secure Digital one Secure Digital card slot (3.3v)

supports 1-bit and 4-bit SDIO card

Ports and Connectors

Infrared standard v1.2 (115 kbps)

Cradle/synchronization connector 26-pin connector

Audio stereo headphone connector

Physical

Dimensions:

Length 117.0 mm (4.61 inches)

122.4 mm (4.82 inches) with wireless 
antenna

Width 77.2 mm (3.04 inches)

Height 14.9 mm (0.59 inch)

Weight 136.5 g (0.30 lb) with standard battery

140.4 g (0.31 lb) with standard battery 
and wireless antenna

Audio

Audio controller AC-97 Codec chip; WM9705 sound 
chip

Stereo conversion 16-bit stereo; 8.0-, 11.025-, 22.05-, and 
44.1-KHz sample rate

Record full duplex record and playback

Microphone/speaker integrated

Headphone stereo connector
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Wireless Connectivity

Dell™ 1210 WLAN Module (802.11b)

Host interface CF+

Network standard IEEE 802.11b

Data rate 1 Mbps, 2 Mbps, 5.5 Mbps, 11 Mbps

Modulation CCK (11 Mpbs, 5.5 Mbps); 
DQPSK (2 Mbps); DBSPK (1 Mbps)

Network architecture ad-hoc and infrastructure

Operating frequencies 2.4–2.497 GHz

Operating channels 1–11 (North America and Japan); 
1–13 (Europe)

RF output power 14.0 dBm typical

Antenna connection single antenna, Hirose W-FL connector

Range indoor — up to 36.58 m (120 ft) at 
11 Mbps; outdoor — up to 121.92 m 
(400 ft) at 11 Mbps

Client utility automatic location profile, site survey, 
diagnostics, current link status, ping

Software support MS ITL certified; Wi-Fi certified

LED indications WLAN link/activity

Switch manual radio on/off (hardware button 
and software switch) to comply with 
aviation restrictions

Bluetooth 2.4-GHz ISM band operation; Bluetooth 
1.1 compatible; includes Bluetooth™ 
manager; Class II device; Max 4 dBm o/p 
power; 1.8 V operation; UART interface
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Power Supply

Battery type:

Main 950-mAh lithium-ion removable, 
rechargeable battery (standard)

1800-mAh lithium-ion removable, 
rechargeable battery (optional)

Backup 20-mAh rechargeable nickel metal 
hydride button cell

AC adapter:

Supply voltage 100–240 VAC

Frequency 50–60 Hz

Current consumption 0.4 A

Output voltage 5.4 VDC

Output current 2.41 A

Environmental

Temperature range:

operating 0° to 40°C (32° to 104°F)

storage –20° to 60°C (–4° to 140°F)

Thermal gradient:

operating 15°C (59°F) per hour maximum

storage 20°C (68°F) per hour maximum

Relative humidity (maximum):

operating 10% to 90% non-condensing

storage 5% to 95% non-condensing

Altitude (maximum):

operating 0 to 3048 m (0 to 10,000 ft)

storage 0 to 12,190 m (0 to 40,000 ft)
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Regulatory Notices
Electromagnetic Interference (EMI) is any signal or emission, radiated in free space or 
conducted along power or signal leads, that endangers the functioning of a radio navigation 
or other safety service or seriously degrades, obstructs, or repeatedly interrupts a licensed 
radio communications service. Radio communications services include but are not limited to 
AM/FM commercial broadcast, television, cellular services, radar, air-traffic control, pager, 
and Personal Communication Services (PCS). These licensed services, along with 
unintentional radiators such as digital devices, including computers, contribute to the 
electromagnetic environment.

Electromagnetic Compatibility is the ability of items of electronic equipment to function 
properly together in the electronic environment. While this computer has been designed and 
determined to be compliant with regulatory agency limits for EMI, there is no guarantee that 
interference will not occur in a particular installation. If this equipment does cause 
interference with radio communications services, which can be determined by turning the 
equipment off and on, you are encouraged to try to correct the interference by one or more of 
the following measures:

• Reorient the receiving antenna.

• Relocate the computer with respect to the receiver.

• Move the computer away from the receiver.

• Plug the computer into a different outlet so that the computer and the receiver are on 
different branch circuits.

If necessary, consult a Dell Technical Support representative or an experienced 
radio/television technician for additional suggestions. 

Maximum shock (measured with a 2 ms 
half-sine pulse):

operating 200 G

storage 400 G

Maximum vibration (using a random-
vibration spectrum that simulates user 
environment):

operating 2.6 GRMS

storage 3.41 GRMS

Environmental (continued)
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Dell™ computers are designed, tested, and classified for their intended electromagnetic 
environment. These electromagnetic environment classifications generally refer to the 
following harmonized definitions:

• Class A is typically for business or industrial environments.

• Class B is typically for residential environments.

Information Technology Equipment (ITE), including devices, expansion cards, printers, 
input/output (I/O) devices, monitors, and so on, that are integrated into or connected to the 
computer should match the electromagnetic environment classification of the computer.

A Notice About Shielded Signal Cables: Use only shielded cables for connecting devices to 
any Dell device to reduce the possibility of interference with radio communications 
services. Using shielded cables ensures that you maintain the appropriate Electromagnetic 
Compatibility classification for the intended environment. For parallel printers, a cable is 
available from Dell. If you prefer, you can order a cable from Dell on the World Wide Web 
at accessories.us.dell.com/sna/category.asp?category_id=4117.

Most Dell computers are classified for Class B environments. However, the inclusion of 
certain options can change the rating of some configurations to Class A. To determine the 
electromagnetic classification for your computer or device, see the following sections specific 
for each regulatory agency. Each section provides country-specific Electromagnetic 
Compatibility/EMI or product safety information.

FCC Notices (U.S. Only)

Most Dell computers are classified by the Federal Communications Commission (FCC) as 
Class B digital devices. To determine which classification applies to your computer, examine 
all FCC registration labels located on the bottom, side, or back panel of your computer, on 
card-mounting brackets, and on the cards themselves. If any one of the labels carries a Class 
A rating, your entire computer is considered to be a Class A digital device. If all labels carry 
an FCC Class B rating as distinguished by either an FCC ID number or the FCC logo, 
( ), your computer is considered to be a Class B digital device.

Once you have determined your computer’s FCC classification, read the appropriate FCC 
notice. Note that FCC regulations provide that changes or modifications not expressly 
approved by Dell could void your authority to operate this equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following 
two conditions:

• This device may not cause harmful interference.

• This device must accept any interference received, including interference that may 
cause undesired operation.

Class B

This equipment has been tested and found to comply with the limits for a Class B digital 
device pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential installation. This equipment 
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generates, uses, and can radiate radio frequency energy and, if not installed and used in 
accordance with the manufacturer’s instruction manual, may cause interference with radio 
communications. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful interference to radio or 
television reception, which can be determined by turning the equipment off and on, you are 
encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and the receiver.

• Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected.

• Consult the dealer or an experienced radio/television technician for help.

FCC Identification Information

The following information is provided on the device or devices covered in this document in 
compliance with FCC regulations: 

• Model numbers: HC02U, HD03U

• Company name: 

Dell Inc.
One Dell Way
Round Rock, Texas 78682 USA
512-338-4400

IC Notice (Canada Only)

Most Dell computers (and other Dell digital apparatus) are classified by the Industry Canada 
(IC) Interference-Causing Equipment Standard #3 (ICES-003) as Class B digital devices. 
To determine which classification (Class A or B) applies to your computer (or other Dell 
digital apparatus), examine all registration labels located on the bottom, side, or the back 
panel of your computer (or other digital apparatus). A statement in the form of "IC Class A 
ICES-003" or "IC Class B ICES-003" will be located on one of these labels. Note that 
Industry Canada regulations provide that changes or modifications not expressly approved by 
Dell could void your authority to operate this equipment.

This Class B (or Class A, if so indicated on the registration label) digital apparatus meets 
the requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la Classe B (ou Classe A, si ainsi indiqué sur l’étiquette 
d’enregistration) respecte toutes les exigences du Reglement sur le Materiel Brouilleur du 
Canada.
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CE Notice (European Union)

Marking by the symbol  indicates compliance of this Dell computer to the 
Electromagnetic Compatibility Directive and the Low Voltage Directive of the European 
Union. Such marking is indicative that this Dell system meets the following technical 
standards:

• EN 55022 — "Information Technology Equipment — Radio Disturbance 
Characteristics — Limits and Methods of Measurement."

• EN 55024 — "Information Technology Equipment - Immunity Characteristics - 
Limits and Methods of Measurement."

• EN 61000-3-2 — "Electromagnetic Compatibility - Part 3: Limits - Section 2: Limits 
for Harmonic Current Emissions (Equipment Input Current Up to and Including 
16 A Per Phase)."

• EN 61000-3-3 — "Electromagnetic Compatibility - Part 3: Limits - Section 3: 
Limitation of Voltage Fluctuations and Flicker in Low-Voltage Supply Systems for 
Equipment With Rated Current Up to and Including 16 A."

• EN 60950 — "Safety of Information Technology Equipment."

NOTE: EN 55022 emissions requirements provide for two classifications:

• Class A is for typical commercial areas.

• Class B is for typical domestic areas.

This Dell device is classified for use in a typical Class B domestic environment.

A "Declaration of Conformity" in accordance with the preceding directives and standards has 
been made and is on file at Dell Inc. Products Europe BV, Limerick, Ireland.

EN 55022 Compliance (Czech Republic Only)

This device belongs to Class B devices as described in EN 55022, unless it is specifically 
stated that it is a Class A device on the specification label. The following applies to 
devices in Class A of EN 55022 (radius of protection up to 30 meters). The user of the 
device is obliged to take all steps necessary to remove sources of interference to 
telecommunication or other devices.
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Australia and New Zealand

VCCI Notice (Japan Only)

Most Dell computers are classified by the Voluntary Control Council for Interference 
(VCCI) as Class B information technology equipment (ITE). However, the inclusion of 
certain options can change the rating of some configurations to Class A. ITE, including 
devices, expansion cards, printers, input/output (I/O) devices, monitors, and so on, 
integrated into or connected to the computer should match the electromagnetic 
environment classification (Class A or B) of the computer.

To determine which classification applies to your computer, examine the regulatory 
labels/markings (see "VCCI Class A ITE Regulatory Mark" and "VCCI Class B ITE 
Regulatory Mark") located on the bottom, side, or back panel of your computer. Once you 
have determined your computer’s VCCI classification, read the appropriate VCCI notice.

Class B ITE

This is a Class B product based on the standard of the Voluntary Control Council for 
Interference (VCCI) for information technology equipment. If this equipment is used near a 
radio or television receiver in a domestic environment, it may cause radio interference. Install 
and use the equipment according to the instruction manual.
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VCCI Class B ITE Regulatory Mark

If the regulatory label includes the following marking, your computer is a Class B product:

MIC Notice (Republic of Korea Only)

To determine which classification (Class A or B) applies to your computer (or other Dell 
digital device), examine the Republic of Korean Ministry of Information and 
Communications (MIC) registration labels located on your computer (or other Dell digital 
device). The MIC label may be located separately from the other regulatory marking applied 
to your product. Line two of the label identifies the emissions class for the product—"(A)" 
for Class A products or "(B)" for Class B products.

NOTE: MIC emissions requirements provide for two classifications:

• Class A devices are for business purposes.

• Class B devices are for nonbusiness purposes.

Class B Device

Please note that this device has been approved for nonbusiness purposes and may be used in 
any environment, including residential areas.
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MIC Class B Regulatory Label

If the regulatory label includes the following marking, your computer is a Class B product.

Polish Center for Testing and Certification Notice

The equipment should draw power from a socket with an attached protection circuit (a 
3-prong socket). All equipment that works together (computer, monitor, printer, and so on) 
should have the same power supply source.

The phasing conductor of the room’s electrical installation should have a reserve short-
circuit protection device in the form of a fuse with a nominal value no larger than 
16 amperes (A).

To completely switch off the equipment, the power supply cable must be removed from the 
power supply socket, which should be located near the equipment and easily accessible.

A protection mark "B" confirms that the equipment is in compliance with the protection 
usage requirements of standards PN-93/T-42107 and PN-EN 55022.
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PN–EN 60950:2000 i PN–EN 55022:2000.
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BSMI Notice (Taiwan Only)

If you find a  or  mark on the regulatory

label on the bottom, side, or back panel of your computer, the following section is applicable:
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NOM Information (Mexico Only)

The following information is provided on the device(s) described in this document in 
compliance with the requirements of the official Mexican standards (NOM): 

Wireless Regulatory Information
The Dell™ Axim™ X30 device must be used in strict accordance with the manufacturer's 
instructions as described in the user documentation that comes with the product. For 
country-specific approvals, see Radio approvals. Dell Inc. is not responsible for any radio or 
television interference caused by unauthorized modification of the device, or the 
substitution or attachment of connecting cables and equipment other than that specified by 
Dell Inc. The correction of interference caused by such unauthorized modification, 
substitution or attachment is the responsibility of the user. Dell Inc. and its authorized 
resellers or distributors are not liable for any damage or violation of government regulations 
that may arise from the user failing to comply with these guidelines.

Exporter: Dell Inc.
One Dell Way
Round Rock, TX 78682

Importer: Dell Computer de México, 
S.A. de C.V. 
Paseo de la Reforma 2620 - 11° Piso 
Col. Lomas Altas 
11950 México, D.F. 

Ship to: Dell Computer de México, 
S.A. de C.V. al Cuidado de Kuehne & 
Nagel de México S. de R.I.
Avenida Soles No. 55
Col. Peñon de los Baños
15520 México, D.F.

Model numbers: HC02U, HD03U

Supply voltage: 100–240 VAC 

Frequency:  50–60 Hz

Current Consumption:  0.4 A

Output voltage: 5.4 VDC

Output current: 2.41 A
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Europe—CE Declaration of Conformity

EN 301 489-1(December 2001), EN 301 489-17 (December 2001), EN 300 328-1 
(August 2002), EN 300 328-2(August 2002), EN60950 (January 2000)

English Hereby, Dell Inc. declares that this HC02U is in compliance with 
the essential requirements and other relevant provisions of 
Directive 1999/5/EC.

Finnish Dell Inc. vakuuttaa täten että HC02U tyyppinen laite on 
direktiivin 1999/5/EY oleellisten vaatimusten ja sitä koskevien 
direktiivin muiden ehtojen mukainen.

Dutch Hierbij verklaart Dell Inc. dat het toestel HC02U in 
overeenstemming is met de essentiële eisen en de andere relevante 
bepalingen van richtlijn 1999/5/EG

Bij deze verklaart Dell Inc. dat deze HC02U voldoet aan de 
essentiële eisen en aan de overige relevante bepalingen van 
Richtlijn 1999/5/EC.

French Par la présente Dell Inc. déclare que l'appareil HC02U est 
conforme aux exigences essentielles et aux autres dispositions 
pertinentes de la directive 1999/5/CE

Par la présente, Dell Inc. déclare que ce HC02U est conforme aux 
exigences essentielles et aux autres dispositions de la directive 
1999/5/CE qui lui sont applicables

Swedish Härmed intygar Dell Inc. att denna HC02U står I 
överensstämmelse med de väsentliga egenskapskrav och övriga 
relevanta bestämmelser som framgår av direktiv 1999/5/EG.

Danish Undertegnede Dell Inc. erklærer herved, at følgende udstyr 
HC02U overholder de væsentlige krav og øvrige relevante krav i 
direktiv 1999/5/EF
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France

Some areas of France have a restricted frequency band. The worst case maximum authorized 
power indoors is:

10 mW for the entire 2.4 GHz band (2400 MHz–2483.5 MHz)

100 mW for frequencies between 2446.5 MHz and 2483.5 MHz (NOTE—Channels 10 
through 13 inclusive operate in the band 2446.6 MHz to 2483.5 MHz)

There are few possibilities for outdoor use: On private property or on the private property of 
public persons, use is subject to a preliminary authorization procedure by the Ministry of 
Defence, with maximum authorized power of 100 mW in the 2446.5–2483.5 MHz band. Use 
outdoors on public property is not permitted.

In the departments listed below, for the entire 2.4 GHz band:

Maximum authorized power indoors is 100 mW 

Maximum authorized power outdoors is 10 mW 

German Hiermit erklärt Dell Inc., dass sich dieser/diese/dieses HC02U in 
Übereinstimmung mit den grundlegenden Anforderungen und 
den anderen relevanten Vorschriften der Richtlinie 1999/5/EG 
befindet". (BMWi)

Hiermit erklärt Dell Inc. die Übereinstimmung des Gerätes 
HC02U mit den grundlegenden Anforderungen und den anderen 
relevanten Festlegungen der Richtlinie 1999/5/EG. (Wien)

Greek ΜΕ ΤΗΝ ΠΑΡΟΥΣΑ Dell Inc. ∆ΗΛΩΝΕΙ ΟΤΙ HC02U 
ΣΥΜΜΟΡΦΩΝΕΤΑΙ ΠΡΟΣ ΤΙΣ ΟΥΣΙΩ∆ΕΙΣ ΑΠΑΙΤΗΣΕΙΣ ΚΑΙ 
ΤΙΣ ΛΟΙΠΕΣ ΣΧΕΤΙΚΕΣ ∆ΙΑΤΑΞΕΙΣ ΤΗΣ Ο∆ΗΓΙΑΣ 1999/5/ΕΚ

Italian Con la presente Dell Inc. dichiara che questo HC02U è conforme 
ai requisiti essenziali ed alle altre disposizioni pertinenti stabilite 
dalla direttiva 1999/5/CE.

Spanish Por medio de la presente Dell Inc. declara que el HC02U cumple 
con los requisitos esenciales y cualesquiera otras disposiciones 
aplicables o exigibles de la Directiva 1999/5/CE

Portuguese Dell Inc. declara que este HC02U está conforme com os requisitos 
essenciais e outras disposições da Directiva 1999/5/CE.



w
w

w
.d

e
ll

.c
o

m
 |

 s
u

p
p

o
r

t.
d

e
ll

.c
o

m

122 Appendix

Departments in which the use of the 2400–2483.5 MHz band is permitted with an EIRP of 
less than 100 mW indoors and less than 10 mW outdoors:

This requirement is likely to change over time, allowing to use your wireless LAN card in 
more areas within France. Please check with ART for the latest information (www.art-
telecom.fr).

NOTE: Your Dell Axim X30 transmits less than 100 mW, but more than 10 mW.

Japan Standard

STD-T66 (Ver 1.0)

01 Ain 

Orientales

36 Indre 66 Pyrénées

02 Aisne 37 Indre et Loire 67 Bas Rhin

03 Allier 41 Loir et Cher 68 Haut Rhin

05 Hautes Alpes 42 Loire 70 Haute Saône

08 Ardennes 45 Loiret 71 Saône et Loire

09 Ariège 50 Manche 75 Paris

11 Aude 55 Meuse 82 Tarn et Garonne

12 Aveyron 58 Nièvre 84 Vaucluse

16 Charente 59 Nord 88 Vosges

24 Dordogne 60 Oise 89 Yonne

25 Doubs 61 Orne 90 Territoire de Belfort

26 Drôme 63 Puy du Dôme 94 Val de Marne

32 Gers 64 Pyrénées 
Atlantique

Italia A license is required for indoor use. Outdoor use is prohibited.

E' necessaria la concessione ministeriale anche per l'uso interno. Verificare 
con i rivenditori la procedura da seguire. L'uso per installazione in esterni 
non e' permessa.
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Canada—Industry Canada (IC)

This device complies with RSS210 of Industry Canada. (1999)

FCC Standard

47 CFR Part 15, Subpart C (Section 15.247). This version is limited to chapter 1 to 
chapter 11 by specified firmware controlled in the U.S.A.

Federal Communications Commission (FCC)

This device complies with Part 15 of the FCC Rules. Operation of the device is subject to the 
following two conditions:

• This device may not cause harmful interference. 

• This device must accept any interference that may cause undesired operation. 

NOTE: The radiated output power of this Dell Axim X30 device is far below the FCC radio 

frequency exposure limits. Nevertheless, the Dell Axim X30 device should be used in such a 

manner that the potential for human contact during normal operation is minimized. To determine 

the location of the antenna within your computer, check the information posted on the general 

Dell support site at support.dell.com.

Interference Statement

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy. If the equipment is not 
installed and used in accordance with the instructions, the equipment may cause harmful 
interference to radio communications. There is no guarantee, however, that such 
interference will not occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception (which can be determined by turning the 
equipment off and on), the user is encouraged to try to correct the interference by taking one 
or more of the following measures:

• Reorient or relocate the receiving antenna. 

• Increase the distance between the equipment and the receiver. 

• Connect the equipment to an outlet on a circuit different from that to which the 
receiver is connected. 

• Consult the dealer or an experienced radio/TV technician for help. 

NOTE: This Dell Axim X30 device must be installed and used in strict accordance with the 

manufacturer's instructions as described in the user documentation that comes with the 

product. Any other installation or use will violate FCC Part 15 regulations.
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NOTE: FCC Radiation Exposure Statement:

This equipment complies with FCC RF radiation exposure limits set forth for an 
uncontrolled environment. End users must follow the specific operating instructions for 
satisfying RF exposure compliance.

Mexico

MEC SCT RCPUSCF02-609 

Singapore—Approved by IDA for Use in Singapore

DA102617

Korea

R-LARN-03-0166

Brazil
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Radio Approvals

To determine whether you are allowed to use your wireless network device in a specific 
country, please check to see if the radio type number that is printed on the identification 
label of your device is listed on the radio approval list posted on the general Dell support site 
at support.dell.com.

Contacting Dell
To contact Dell electronically, you can access the following websites:

• www.dell.com

• support.dell.com (technical support)

• premiersupport.dell.com (technical support for educational, 
government, healthcare, and medium/large business customers, 
including Premier, Platinum, and Gold customers)

For specific web addresses for your country, find the appropriate country 
section in the table below. 

NOTE: Toll-free numbers are for use within the country for which they are listed.

When you need to contact Dell, use the electronic addresses, telephone 
numbers, and codes provided in the following table. If you need assistance in 
determining which codes to use, contact a local or an international operator.

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers

Anguilla General Support toll-free: 800-335-
0031

Antigua and Barbuda General Support 1-800-805-5924

Argentina (Buenos 
Aires)

International Access 
Code: 00

Country Code: 54

City Code: 11

Website: www.dell.com.ar

Tech Support and Customer Care  toll-free: 0-800-444-
0733

Sales 0-810-444-3355

Tech Support Fax  11 4515 7139

Customer Care Fax  11 4515 7138
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Aruba General Support toll-free: 800-1578

Australia (Sydney)

International Access 
Code: 0011

Country Code: 61

City Code: 2

E-mail (Australia): 
au_tech_support@dell.com

E-mail (New Zealand): 
nz_tech_support@dell.com

Home and Small Business 1-300-65-55-33

Government and Business toll-free: 1-800-633-
559

Preferred Accounts Division (PAD) toll-free: 1-800-060-
889

Customer Care toll-free: 1-800-819-
339

Corporate Sales toll-free: 1-800-808-
385

Transaction Sales toll-free: 1-800-808-
312

Fax toll-free: 1-800-818-
341

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Austria (Vienna)

International Access 
Code: 900

Country Code: 43

City Code: 1

Website: support.euro.dell.com

E-mail: 
tech_support_central_europe@del
l.com

Home/Small Business Sales 0820 240 530 00

Home/Small Business Fax 0820 240 530 49

Home/Small Business Customer 
Care

0820 240 530 14

Preferred Accounts/Corporate 
Customer Care

0820 240 530 16

Home/Small Business Technical 
Support

0820 240 530 14

Preferred Accounts/Corporate 
Technical Support

0660 8779

Switchboard 0820 240 530 00

Bahamas General Support toll-free: 1-866-278-
6818

Barbados General Support 1-800-534-3066

Belgium (Brussels)

International Access 
Code: 00

Country Code: 32

City Code: 2

Website: support.euro.dell.com

E-mail: tech_be@dell.com

E-mail for French Speaking 
Customers: 
support.euro.dell.com/be/fr/email
dell/

Technical Support 02 481 92 88

Customer Care 02 481 91 19

Corporate Sales 02 481 91 00

Fax 02 481 92 99

Switchboard 02 481 91 00

Bermuda General Support 1-800-342-0671

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Bolivia General Support toll-free: 800-10-0238

Brazil

International Access 
Code: 00

Country Code: 55

City Code: 51

Website: www.dell.com/br

Customer Support, Technical 
Support

0800 90 3355

Tech Support Fax  51 481 5470

Customer Care Fax  51 481 5480

Sales 0800 90 3390

British Virgin Islands General Support toll-free: 1-866-278-
6820

Brunei

Country Code: 673

Customer Technical Support 
(Penang, Malaysia)

604 633 4966

Customer Service (Penang, 
Malaysia)

604 633 4949

Transaction Sales (Penang, 
Malaysia)

604 633 4955

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Canada (North York, 
Ontario)

International Access 
Code: 011

Online Order Status: 
www.dell.ca/ostatus

AutoTech (automated technical 
support)

toll-free: 1-800-247-
9362

TechFax toll-free: 1-800-950-
1329

Customer Care (Home Sales/Small 
Business)

toll-free: 1-800-847-
4096

Customer Care (med./large 
business, government)

toll-free: 1-800-326-
9463

Technical Support (Home 
Sales/Small Business)

toll-free: 1-800-847-
4096

Technical Support (med./large 
bus., government)

toll-free: 1-800-387-
5757

Sales (Home Sales/Small Business) toll-free: 1-800-387-
5752

Sales (med./large bus., 
government)

toll-free: 1-800-387-
5755

Spare Parts Sales & Extended 
Service Sales

1 866 440 3355

Cayman Islands General Support 1-800-805-7541

Chile (Santiago)

Country Code: 56

City Code: 2

Sales, Customer Support, and 
Technical Support

toll-free: 1230-020-
4823

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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China (Xiamen)

Country Code: 86

City Code: 592

Tech Support website: 
support.dell.com.cn

Tech Support E-mail: 
cn_support@dell.com

Tech Support Fax 818 1350

Technical Support (Dimension™ 
and Inspiron™)

toll-
free: 800 858 2969

Technical Support (OptiPlex™, 
Latitude™, and Dell Precision™)

toll-free: 800
858 0950

Technical Support (servers and 
storage)

toll-free: 800
858 0960

Technical Support (projectors, 
PDAs, printers, switches, routers, 
and so on)

toll-
free: 800 858 2920

Customer Experience toll-
free: 800 858 2060

Home and Small Business toll-
free: 800 858 2222

Preferred Accounts Division toll-
free: 800 858 2557

Large Corporate Accounts GCP toll-
free: 800 858 2055

Large Corporate Accounts Key 
Accounts

toll-
free: 800 858 2628

Large Corporate Accounts North toll-
free: 800 858 2999

Large Corporate Accounts North 
Government and Education

toll-
free: 800 858 2955

Large Corporate Accounts East toll-
free: 800 858 2020

Large Corporate Accounts East 
Government and Education

toll-
free: 800 858 2669

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Large Corporate Accounts Queue 
Team

toll-
free: 800 858 2222

Large Corporate Accounts South toll-
free: 800 858 2355

Large Corporate Accounts West toll-
free: 800 858 2811

Large Corporate Accounts Spare 
Parts 

toll-
free: 800 858 2621

Colombia General Support 980-9-15-3978

Costa Rica General Support 0800-012-0435

Czech Republic 
(Prague)

International Access 
Code: 00

Country Code: 420

City Code: 2

Website: support.euro.dell.com

E-mail: czech_dell@dell.com

Technical Support 02  2186 27 27

Customer Care 02  2186 27 11

Fax 02  2186 27 14

TechFax 02  2186 27 28

Switchboard 02  2186 27 11

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Denmark 
(Copenhagen)

International Access 
Code: 00

Country Code: 45 

Website: support.euro.dell.com

E-mail Support (portable 
computers): 
den_nbk_support@dell.com

E-mail Support (desktop 
computers): 
den_support@dell.com

E-mail Support (servers): 
Nordic_server_support@dell.com

Technical Support 7023 0182

Customer Care (Relational) 7023 0184

Home/Small Business Customer 
Care

3287 5505

Switchboard (Relational) 3287 1200

Fax Switchboard (Relational) 3287 1201

Switchboard (Home/Small 
Business)

3287 5000

Fax Switchboard (Home/Small 
Business)

3287 5001

Dominica General Support toll-free: 1-866-278-
6821

Dominican Republic General Support 1-800-148-0530

Ecuador General Support toll-free: 999-119

El Salvador General Support 01-899-753-0777

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Finland (Helsinki)

International Access 
Code: 990

Country Code: 358

City Code: 9

Website: support.euro.dell.com

E-mail: fin_support@dell.com

E-mail Support (servers): 
Nordic_support@dell.com

Technical Support 09 253 313 60

Technical Support Fax 09 253 313 81

Relational Customer Care 09 253 313 38

Home/Small Business Customer 
Care

09 693 791 94

Fax 09 253 313 99

Switchboard 09 253 313 00

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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France (Paris) 
(Montpellier)

International Access 
Code: 00

Country Code: 33

City Codes: (1) (4)

Website: support.euro.dell.com

E-mail: 
support.euro.dell.com/fr/fr/emaild
ell/

Home and Small Business

Technical Support 0825 387 270

Customer Care 0825 823 833

Switchboard 0825 004 700

Switchboard (calls from outside of 
France)

04 99 75 40 00

Sales 0825 004 700

Fax 0825 004 701

Fax (calls from outside of France) 04 99 75 40 01

Corporate

Technical Support 0825 004 719

Customer Care 0825 338 339

Switchboard 01 55 94 71 00

Sales 01 55 94 71 00

Fax 01 55 94 71 01

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Germany (Langen)

International Access 
Code: 00

Country Code: 49

City Code: 6103

Website: support.euro.dell.com

E-mail: 
tech_support_central_europe@del
l.com

Technical Support 06103 766-7200

Home/Small Business Customer 
Care

0180-5-224400

Global Segment Customer Care 06103 766-9570

Preferred Accounts Customer Care 06103 766-9420

Large Accounts Customer Care 06103 766-9560

Public Accounts Customer Care 06103 766-9555

Switchboard 06103 766-7000

Greece

International Access 
Code: 00

Country Code: 30

Website: support.euro.dell.com

E-mail: 
support.euro.dell.com/gr/en/email
dell/

Technical Support 080044149518

Gold Technical Support 08844140083

Switchboard 2108129800

Sales 2108129800

Fax 2108129812

Grenada General Support toll-free: 1-866-540-
3355

Guatemala General Support 1-800-999-0136

Guyana General Support toll-free: 1-877-270-
4609

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Hong Kong

International Access 
Code: 001

Country Code: 852

Website: support.ap.dell.com

E-mail: ap_support@dell.com

Technical Support (Dimension™ 
and Inspiron™)

2969 3189

Technical Support (OptiPlex™, 
Latitude™, and Dell Precision™)

2969 3191

Technical Support (PowerApp™, 
PowerEdge™, PowerConnect™, 
and PowerVault™)

2969 3196

Gold Queue EEC Hotline 2969 3187

Customer Advocacy 3416 0910

Large Corporate Accounts 3416 0907

Global Customer Programs 3416 0908

Medium Business Division 3416 0912

Home and Small Business Division 2969 3105

India Technical Support 1600 33 8045

Sales 1600 33 8044

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Ireland 
(Cherrywood)

International Access 
Code: 16

Country Code: 353

City Code: 1

Website: support.euro.dell.com

E-mail: 
dell_direct_support@dell.com

 Technical Support 1850 543 543

U.K. Technical Support (dial 
within U.K. only)

0870 908 0800

Home User Customer Care 01 204 4014

Small Business Customer Care 01 204 4014

U.K. Customer Care (dial within 
U.K. only)

0870 906 0010

Corporate Customer Care 1850 200 982

Corporate Customer Care (dial 
within U.K. only)

0870 907 4499

Ireland Sales 01 204 4444

U.K. Sales (dial within U.K. only) 0870 907 4000

Fax/SalesFax 01 204 0103

Switchboard 01 204 4444

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Italy (Milan)

International Access 
Code: 00

Country Code: 39

City Code: 02

Website: support.euro.dell.com

E-mail: 
support.euro.dell.com/it/it/emaild
ell/

Home and Small Business

Technical Support 02 577 826 90

Customer Care 02 696 821 14

Fax 02 696 821 13

Switchboard 02 696 821 12

Corporate

Technical Support 02 577 826 90

Customer Care 02 577 825 55

Fax 02 575 035 30

Switchboard 02 577 821

Jamaica General Support (dial from within 
Jamaica only)

1-800-682-3639

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Japan (Kawasaki)

International Access 
Code: 001

Country Code: 81

City Code: 44

Website: support.jp.dell.com

Technical Support (servers) toll-free: 0120-198-
498

Technical Support outside of Japan 
(servers)

81-44-556-4162

Technical Support (Dimension™ 
and Inspiron™)

toll-free: 0120-198-
226

Technical Support outside of Japan 
(Dimension and Inspiron)

81-44-520-1435

Technical Support (Dell 
Precision™, OptiPlex™, and 
Latitude™)

toll-free:0120-198-
433

Technical Support outside of Japan 
(Dell Precision, OptiPlex, and 
Latitude)

81-44-556-3894

Technical Support (Axim™) toll-free: 0120-981-
690

Technical Support outside of Japan 
(Axim)

81-44-556-3468

Faxbox Service 044-556-3490

24-Hour Automated Order Service 044-556-3801

Customer Care 044-556-4240

Business Sales Division (up to 400 
employees)

044-556-1465

Preferred Accounts Division Sales 
(over 400 employees)

044-556-3433

Large Corporate Accounts Sales 
(over 3500 employees)

044-556-3430

Public Sales (government agencies, 
educational institutions, and 
medical institutions)

044-556-1469

Global Segment Japan 044-556-3469

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Individual User 044-556-1760

Switchboard 044-556-4300

Korea (Seoul)

International Access 
Code: 001

Country Code: 82

City Code: 2

Technical Support toll-free: 080-200-
3800

Sales toll-free: 080-200-
3600

Customer Service (Seoul, Korea) toll-free: 080-200-
3800

Customer Service (Penang, 
Malaysia)

604 633 4949

Fax 2194-6202

Switchboard 2194-6000

Latin America Customer Technical Support 
(Austin, Texas, U.S.A.)

512 728-4093

Customer Service (Austin, Texas, 
U.S.A.)

512 728-3619

Fax (Technical Support and 
Customer Service) (Austin, Texas, 
U.S.A.)

512 728-3883

Sales (Austin, Texas, U.S.A.) 512 728-4397

SalesFax (Austin, Texas, U.S.A.) 512 728-4600

or 512 728-3772

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Luxembourg

International Access 
Code: 00

Country Code: 352

Website: support.euro.dell.com

E-mail: tech_be@dell.com

Technical Support (Brussels, 
Belgium)

3420808075

Home/Small Business Sales 
(Brussels, Belgium)

toll-free: 080016884

Corporate Sales (Brussels, 
Belgium)

02 481 91 00

Customer Care (Brussels, 
Belgium)

02 481 91 19

Fax (Brussels, Belgium) 02 481 92 99

Switchboard (Brussels, Belgium) 02 481 91 00

Macao

Country Code: 853

Technical Support toll-free: 0800 582

Customer Service (Penang, 
Malaysia)

604 633 4949

Transaction Sales toll-free: 0800 581

Malaysia (Penang)

International Access 
Code: 00

Country Code: 60

City Code: 4

Technical Support (Dell Precision, 
OptiPlex, and Latitude)

toll-
free: 1 800 88 0193

Technical Support (Dimension 
and Inspiron)

toll-
free: 1 800 88 1306

Customer Service 04 633 4949

Transaction Sales toll-
free: 1 800 888 202

Corporate Sales toll-
free: 1 800 888 213

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Mexico

International Access 
Code: 00

Country Code: 52

Customer Technical Support 001-877-384-8979

or 001-877-269-3383

Sales 50-81-8800

or 01-800-888-3355

Customer Service 001-877-384-8979

or 001-877-269-3383

Main 50-81-8800

or 01-800-888-3355

Montserrat General Support toll-free: 1-866-278-
6822

Netherlands Antilles General Support 001-800-882-1519

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Netherlands 
(Amsterdam)

International Access 
Code: 00

Country Code: 31

City Code: 20

Website: support.euro.dell.com

E-mail (Technical Support):

(Enterprise): 
nl_server_support@dell.com

(Latitude): 
nl_latitude_support@dell.com

(Inspiron): 
nl_inspiron_support@dell.com

(Dimension): 
nl_dimension_support@dell.com

(OptiPlex): 
nl_optiplex_support@dell.com

(Dell Precision): 
nl_workstation_support@dell.com

Technical Support 020 674 45 00

Technical Support Fax 020 674 47 66

Home/Small Business Customer 
Care

020 674 42 00

Relational Customer Care  020 674 4325

Home/Small Business Sales 020 674 55 00

Relational Sales 020 674 50 00

Home/Small Business Sales Fax 020 674 47 75

Relational Sales Fax 020 674 47 50

Switchboard 020 674 50 00

Switchboard Fax 020 674 47 50

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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New Zealand

International Access 
Code: 00

Country Code: 64

E-mail (New Zealand): 
nz_tech_support@dell.com

E-mail (Australia): 
au_tech_support@dell.com

Home and Small Business 0800 446 255

Government and Business 0800 444 617

Sales 0800 441 567

Fax 0800 441 566

Nicaragua General Support 001-800-220-1006

Norway (Lysaker)

International Access 
Code: 00

Country Code: 47

Website: support.euro.dell.com

E-mail Support (portable 
computers):

nor_nbk_support@dell.com

E-mail Support (desktop 
computers):

nor_support@dell.com

E-mail Support (servers):

nordic_server_support@dell.com

Technical Support 671 16882

Relational Customer Care 671 17514

Home/Small Business Customer 
Care

23162298

Switchboard 671 16800

Fax Switchboard 671 16865

Panama General Support 001-800-507-0962

Peru General Support 0800-50-669

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Poland (Warsaw)

International Access 
Code: 011

Country Code: 48

City Code: 22

Website: support.euro.dell.com

E-mail: 
pl_support_tech@dell.com

Customer Service Phone 57 95 700

Customer Care 57 95  999

Sales 57 95 999

Customer Service Fax 57 95 806

Reception Desk Fax 57 95 998

Switchboard 57 95 999

Portugal

International Access 
Code: 00

Country Code: 351

Website: support.euro.dell.com

E-mail: 
support.euro.dell.com/pt/en/email
dell/

Technical Support 707200149

Customer Care 800 300 413

Sales 800 300 410 or
800 300 411 or
800 300 412 or

21 422 07 10

Fax 21 424 01 12

Puerto Rico General Support 1-800-805-7545

St. Kitts and Nevis General Support toll-free: 1-877-441-
4731

St. Lucia General Support 1-800-882-1521

St. Vincent and the 
Grenadines

General Support toll-free: 1-877-270-
4609

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Singapore 
(Singapore)

International Access 
Code: 005

Country Code: 65

Technical Support toll-
free: 800 6011 051

Customer Service (Penang, 
Malaysia)

604 633 4949

Transaction Sales toll-
free: 800 6011 054

Corporate Sales toll-
free: 800 6011 053

South Africa 
(Johannesburg)

International Access 
Code:

09/091

Country Code: 27

City Code: 11

Website: support.euro.dell.com

E-mail: dell_za_support@dell.com

Technical Support 011 709 7710

Customer Care 011 709 7707

Sales 011 709 7700

Fax 011 706 0495

Switchboard 011 709 7700

Southeast Asian and 
Pacific Countries

Customer Technical Support, 
Customer Service, and Sales 
(Penang, Malaysia)

604 633 4810

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Spain (Madrid)

International Access 
Code: 00

Country Code: 34

City Code: 91

Website: support.euro.dell.com

E-mail: 
support.euro.dell.com/es/es/email
dell/

Home and Small Business

Technical Support 902 100 130

Customer Care 902 118 540

Sales 902 118 541

Switchboard 902 118 541

Fax 902 118 539

Corporate

Technical Support 902 100 130

Customer Care 902 118 546

Switchboard 91 722 92 00

Fax 91 722 95 83

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Sweden (Upplands 
Vasby)

International Access 
Code: 00

Country Code: 46

City Code: 8

Website: support.euro.dell.com

E-mail: swe_support@dell.com

E-mail Support for Latitude and 
Inspiron: 
Swe-nbk_kats@dell.com

E-mail Support for OptiPlex: 
Swe_kats@dell.com

E-mail Support for Servers: 
Nordic_server_support@dell.com

Technical Support 08 590 05 199

Relational Customer Care 08 590 05 642

Home/Small Business Customer 
Care

08 587 70 527

Employee Purchase Program 
(EPP) Support

20 140 14 44

Fax Technical Support 08 590 05 594

Sales 08 590 05 185

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Switzerland 
(Geneva)

International Access 
Code: 00

Country Code: 41

City Code: 22

Website: support.euro.dell.com

E-mail: swisstech@dell.com

E-mail for French-speaking HSB 
and Corporate Customers: 
support.euro.dell.com/ch/fr/email
dell/

Technical Support (Home and 
Small Business)

0844 811 411

Technical Support (Corporate) 0844 822 844

Customer Care (Home and Small 
Business)

0848 802 202

Customer Care (Corporate) 0848 821 721

Fax 022 799 01 90

Switchboard 022 799 01 01

Taiwan

International Access 
Code: 002

Country Code: 886

Technical Support (portable and 
desktop computers)

toll-
free: 00801 86 1011

Technical Support (servers) toll-
free: 0080 60 1256

Transaction Sales toll-
free: 0080 651 228

Corporate Sales toll-
free: 0080 651 227

Thailand

International Access 
Code: 001

Country Code: 66

Technical Support toll-free: 0880 060 07

Customer Service (Penang, 
Malaysia)

604 633 4949

Sales toll-free: 0880 060 09

Trinidad/Tobago General Support 1-800-805-8035

Turks and Caicos 
Islands

General Support toll-free: 1-866-540-
3355

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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U.K. (Bracknell)

International Access 
Code: 00

Country Code: 44

City Code: 1344

Website: support.euro.dell.com

Customer Care website: 
support.euro.dell.com/uk/en/ECare/Form/Home.asp

E-mail: 
dell_direct_support@dell.com

Technical Support 
(Corporate/Preferred 
Accounts/PAD [1000+ 
employees])

0870 908 0500

Technical Support (direct/PAD 
and general)

0870 908 0800

Global Accounts Customer Care 01344 373 186

Home and Small Business 
Customer Care 

0870 906 0010

Corporate Customer Care 01344 373 185

Preferred Accounts (500–5000 
employees) Customer Care

0870 906 0010

Central Government Customer 
Care

01344 373 193

Local Government & Education 
Customer Care

01344 373 199

Health Customer Care 01344 373 194

Home and Small Business Sales 0870 907 4000

Corporate/Public Sector Sales 01344 860 456

Home and Small Business Fax 0870 907 4006

Uruguay General Support toll-free: 000-413-
598-2521

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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U.S.A. (Austin, 
Texas)

International Access 
Code: 011

Country Code: 1

Automated Order-Status Service toll-free: 1-800-433-
9014

AutoTech (portable and desktop 
computers)

toll-free: 1-800-247-
9362

Consumer (Home and Home Office) 

Technical Support toll-free: 1-800-624-
9896

Customer Service toll-free: 1-800-624-
9897

DellNet™ Service and Support toll-free: 1-877-Dell-
net

(1-877-335-5638)

Employee Purchase Program 
(EPP) Customers

toll-free: 1-800-695-
8133

Financial Services website: 
www.dellfinancialservices.com

Financial Services (lease/loans) toll-free: 1-877-577-
3355

Financial Services (Dell Preferred 
Accounts [DPA])

toll-free: 1-800-283-
2210

Business 

Customer Service and Technical 
Support

toll-free: 1-800-822-
8965

Employee Purchase Program 
(EPP) Customers

toll-free: 1-800-695-
8133

Printers and Projectors Technical 
Support

toll-free: 1-877-459-
7298

Public (government, education, and healthcare)

Customer Service and Technical 
Support

toll-free: 1-800-456-
3355

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Employee Purchase Program 
(EPP) Customers

toll-free: 1-800-234-
1490

Dell Sales toll-free: 1-800-289-
3355

 or toll-free: 1-800-
879-3355

Dell Outlet Store (Dell refurbished 
computers)

toll-free: 1-888-798-
7561

Software and Peripherals Sales toll-free: 1-800-671-
3355

Spare Parts Sales toll-free: 1-800-357-
3355

Extended Service and Warranty 
Sales

toll-free: 1-800-247-
4618

Fax toll-free: 1-800-727-
8320

Dell Services for the Deaf, Hard-
of-Hearing, or Speech-Impaired

toll-free: 1-877-
DELLTTY

(1-877-335-5889)

U.S. Virgin Islands General Support 1-877-673-3355

Venezuela General Support 8001-3605

Country (City)

International Access 

Code Country Code

City Code

Department Name or Service Area,

Website and E-Mail Address

Area Codes,

Local Numbers, and

Toll-Free Numbers
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Limited Warranties
Dell-branded hardware products purchased in the U.S. or Canada come with either a 90-day, 
1-year, 2-year, 3-year, or 4-year limited warranty. To determine which warranty came with 
your hardware product(s), see your packing slip or invoice. The following sections describe 
the limited warranties for the U.S., the limited warranties for Canada, the manufacturer 
guarantee for Latin America and the Caribbean, and the Intel® Pentium® and Celeron® 
warranty for the U.S. and Canada.

Limited Warranty for Dell-Branded Hardware Products 

(U.S. Only)

What is covered by this limited warranty?

This limited warranty covers defects in materials and workmanship in your—our end-user 
customer's—Dell-branded hardware products, including Dell-branded peripheral products.

What is not covered by this limited warranty?

This limited warranty does not cover: 

• Software, including the operating system and software added to the Dell-branded 
hardware products through our factory-integration system, third-party software, or the 
reloading of software

• Non-Dell-branded and Solution Provider Direct products and accessories

• Problems that result from: 

– External causes such as accident, abuse, misuse, or problems with electrical 
power

– Servicing not authorized by Dell 

– Usage that is not in accordance with product instructions

– Failure to follow the product instructions or failure to perform preventive 
maintenance 

– Problems caused by using accessories, parts, or components not supplied by Dell

• Products with missing or altered Service Tags or serial numbers

• Products for which Dell has not received payment
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THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO 
HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE (OR 
JURISDICTION TO JURISDICTION). DELL'S RESPONSIBILITY FOR 
MALFUNCTIONS AND DEFECTS IN HARDWARE IS LIMITED TO REPAIR AND 
REPLACEMENT AS SET FORTH IN THIS WARRANTY STATEMENT. ALL 
EXPRESS AND IMPLIED WARRANTIES FOR THE PRODUCT, INCLUDING BUT 
NOT LIMITED TO ANY IMPLIED WARRANTIES AND CONDITIONS OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE 
LIMITED IN TIME TO THE TERM OF THE LIMITED WARRANTY PERIOD 
REFLECTED ON YOUR PACKING SLIP OR INVOICE. NO WARRANTIES, 
WHETHER EXPRESS OR IMPLIED, WILL APPLY AFTER THE LIMITED 
WARRANTY PERIOD HAS EXPIRED. SOME STATES DO NOT ALLOW 
LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THIS 
LIMITATION MAY NOT APPLY TO YOU.

WE DO NOT ACCEPT LIABILITY BEYOND THE REMEDIES PROVIDED FOR IN 
THIS LIMITED WARRANTY OR FOR CONSEQUENTIAL OR INCIDENTAL 
DAMAGES, INCLUDING, WITHOUT LIMITATION, ANY LIABILITY FOR THIRD-
PARTY CLAIMS AGAINST YOU FOR DAMAGES, FOR PRODUCTS NOT BEING 
AVAILABLE FOR USE, OR FOR LOST DATA OR LOST SOFTWARE. OUR 
LIABILITY WILL BE NO MORE THAN THE AMOUNT YOU PAID FOR THE 
PRODUCT THAT IS THE SUBJECT OF A CLAIM. THIS IS THE MAXIMUM 
AMOUNT FOR WHICH WE ARE RESPONSIBLE.

SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION 
OR EXCLUSION MAY NOT APPLY TO YOU.

How long does this limited warranty last?

This limited warranty lasts for the time period indicated on your packing slip or invoice, 
except for the following Dell-branded hardware:

• Portable computer batteries carry a 1-year limited warranty.

• Projector lamps carry a 90-day limited warranty. 

• Memory carries a lifetime limited warranty. 

• Monitors carry the longer of either a 3-year limited warranty or the remainder of the 
warranty for the Dell computer to which the monitor will be connected.

• Other add-on hardware carries the longer of either a 1-year limited warranty for new 
parts and a 90-day limited warranty for reconditioned parts or, for both new and 
reconditioned parts, the reminder of the warranty for the Dell computer on which 
such parts are installed.
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The limited warranty on all Dell-branded products begins on the date of the packing slip or 
invoice. The warranty period is not extended if we repair or replace a warranted product or 
any parts. Dell may change the availability of limited warranties, at its discretion, but any 
changes will not be retroactive.

What do I do if I need warranty service? 

Before the warranty expires, please call us at the relevant number listed in the following 
table. Please also have your Dell Service Tag or order number available. 

What will Dell do?

During the 90 days of the 90-day limited warranty and the first year of all other limited 
warranties: During the 90 days of the 90-day limited warranty and the first year of all other 
limited warranties, we will repair any Dell-branded hardware products returned to us that 
prove to be defective in materials or workmanship. If we are not able to repair the product, 
we will replace it with a comparable product that is new or refurbished. 

When you contact us, we will issue a Return Material Authorization Number for you to 
include with your return. You must return the products to us in their original or equivalent 
packaging, prepay shipping charges, and insure the shipment or accept the risk if the product 
is lost or damaged in shipment. We will return the repaired or replacement products to you. 
We will pay to ship the repaired or replaced products to you if you use an address in the 
United States (excluding Puerto Rico and U.S. possessions and territories). Otherwise, we 
will ship the product to you freight collect.

Individual Home Consumers: U.S. Only

Technical Support 1-800-624-9896

Customer Service 1-800-624-9897

Individual Home Consumers who purchased 

through an Employee Purchase Program:

Technical Support and Customer Service 1-800-822-8965

Home and Small Business Commercial Customers:

Technical Support and Customer Service 1-800-456-3355

Medium, Large, or Global Commercial Customers, 

Healthcare Customers, and Value-Added Resellers 

(VARs):

Technical Support and Customer Service 1-800-822-8965

Government and Education Customers: 

Technical Support and Customer Service 1-800-234-1490

Dell-Branded Memory 1-888-363-5150
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If we determine that the product is not covered under this warranty, we will notify you and 
inform you of service alternatives that are available to you on a fee basis.

NOTE: Before you ship the product(s) to us, make sure to back up the data on the hard 

drive(s) and any other storage device(s) in the product(s). Remove any confidential, 

proprietary, or personal information and removable media such as floppy disks, CDs, or PC 

Cards. We are not responsible for any of your confidential, proprietary, or personal 

information; lost or corrupted data; or damaged or lost removable media. 

During the remaining years: For the remaining period of the limited warranty, we will replace 
any defective part with new or refurbished parts, if we agree that it needs to be replaced. 
When you contact us, we will require a valid credit card number at the time you request a 
replacement part, but we will not charge you for the replacement part as long as you return 
the original part to us within 30 days after we ship the replacement part to you. If we do not 
receive the original part within 30 days, we will charge to your credit card the then-current 
standard price for that part. 

We will pay to ship the part to you if you use an address in the United States (excluding 
Puerto Rico and U.S. possessions and territories). Otherwise, we will ship the part freight 
collect. We will also include a prepaid shipping container with each replacement part for 
your use in returning the replaced part to us. 

NOTE: Before you replace parts, make sure to back up the data on the hard drive(s) and any 

other storage device(s) in the product(s). We are not responsible for lost or corrupted data. 

What if I purchased a service contract?

If your service contract is with Dell, service will be provided to you under the terms of the 
service agreement. Please refer to that contract for details on how to obtain service.

If you purchased through us a service contract with one of our third-party service providers, 
please refer to that contract for details on how to obtain service. 

How will you fix my product?

We use new and refurbished parts made by various manufacturers in performing warranty 
repairs and in building replacement parts and systems. Refurbished parts and systems are 
parts or systems that have been returned to Dell, some of which were never used by a 
customer. All parts and systems are inspected and tested for quality. Replacement parts and 
systems are covered for the remaining period of the limited warranty for the product you 
bought. Dell owns all parts removed from repaired products.
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May I transfer the limited warranty?

Limited warranties on systems may be transferred if the current owner transfers ownership of 
the system and records the transfer with us. The limited warranty on Dell-branded memory 
may not be transferred. You may record your transfer by going to Dell's website: 

• If you are an Individual Home Consumer, go to 
www.dell.com/us/en/dhs/topics/sbtopic_015_ccare.htm 

• If you are a Home Office, Small, Medium, Large, or Global Commercial Customer, go 
to www.dell.com/us/en/biz/topics/sbtopic_ccare_nav_015_ccare.htm 

• If you are a Government, Education, or Healthcare Customer, or an Individual Home 
Consumer who purchased through an Employee Purchase Program, go to 
www.dell.com/us/en/pub/topics/sbtopic_015_ccare.htm

If you do not have Internet access, call your customer care representative or 
call 1-800-624-9897. 

Limited Warranty Terms for Dell-Branded Hardware Products 

(Canada Only)

What is covered by this limited warranty?

This limited warranty covers defects in materials and workmanship in your—our end-user 
customer's—Dell-branded hardware products, including Dell-branded peripheral products.

What is not covered by this limited warranty?

This limited warranty does not cover:

• Software, including the operating system and software added to the Dell-branded 
hardware products through our factory-integration system, or the reloading of the 
software

• Non-Dell branded and Solution Provider Direct products and accessories

• Problems that result from:

– External causes such as accident, abuse, misuse, or problems with electrical 
power

– Servicing not authorized by Dell

– Usage that is not in accordance with product instructions

– Failure to follow the product instructions or failure to perform preventive 
maintenance 

– Problems caused by using accessories, parts, or components not supplied by Dell
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• Products with missing or altered Service Tags or serial numbers

• Products for which Dell has not received payment

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO 
HAVE OTHER RIGHTS WHICH VARY FROM PROVINCE TO PROVINCE. DELL'S 
RESPONSIBILITY FOR MALFUNCTIONS AND DEFECTS IN PRODUCT IS LIMITED 
TO REPAIR AND REPLACEMENT AS SET FORTH IN THIS WARRANTY 
STATEMENT, FOR THE TERM OF THE WARRANTY PERIOD REFLECTED ON 
YOUR PACKING SLIP OR INVOICE. EXCEPT FOR THE EXPRESS WARRANTIES 
CONTAINED IN THIS WARRANTY STATEMENT, DELL DISCLAIMS ALL OTHER 
WARRANTIES AND CONDITIONS, EXPRESS OR IMPLIED, INCLUDING WITHOUT 
LIMITATION IMPLIED WARRANTIES AND CONDITIONS OF MERCHANTABILITY 
AND FITNESS FOR A PARTICULAR PURPOSE, STATUTORY OR OTHERWISE. 
SOME PROVINCES DO NOT ALLOW THE EXCLUSION OF CERTAIN IMPLIED 
WARRANTIES OR CONDITIONS, OR LIMITATIONS ON HOW LONG AN IMPLIED 
WARRANTY OR CONDITION LASTS. THEREFORE, THE FOREGOING 
EXCLUSIONS AND LIMITATIONS MAY NOT APPLY TO YOU. 

WE DO NOT ACCEPT LIABILITY BEYOND THE REMEDIES PROVIDED FOR IN 
THIS WARRANTY STATEMENT OR FOR SPECIAL, INDIRECT, CONSEQUENTIAL, 
OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION, ANY 
LIABILITY FOR THIRD-PARTY CLAIMS AGAINST YOU FOR DAMAGES, FOR 
PRODUCTS NOT BEING AVAILABLE FOR USE, OR FOR LOST DATA OR LOST 
SOFTWARE. OUR LIABILITY WILL BE NO MORE THAN THE AMOUNT YOU PAID 
FOR THE PRODUCT THAT IS THE SUBJECT OF A CLAIM. THIS IS THE MAXIMUM 
AMOUNT FOR WHICH WE ARE RESPONSIBLE.

SOME PROVINCES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF 
SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, SO THE 
ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

How long does this limited warranty last?

This limited warranty lasts for the time period indicated on your packing slip or invoice, 
except that the limited warranty on Dell-branded batteries lasts only 1 year and the limited 
warranty on the lamps for Dell-branded projectors lasts only 90 days. The limited warranty 
begins on the date of the packing slip or invoice. The warranty period is not extended if we 
repair or replace a warranted product or any parts. Dell may change the terms and availability 
of limited warranties, at its discretion, but any changes will not be retroactive (that is, the 
warranty terms in place at the time of purchase will apply to your purchase).
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What do I do if I need warranty service? 

Before the warranty expires, please call us at the relevant number listed in the following 
table. Please also have your Dell Service Tag or order number available.

What will Dell do?

During the 90 days of the 90-day limited warranty and the first year of all other limited 
warranties: During the 90 days of the 90-day limited warranty and the first year of all other 
limited warranties, we will repair any Dell-branded hardware products returned to us that 
prove to be defective in materials or workmanship. If we are not able to repair the product, 
we will replace it with a comparable product that is new or refurbished. 

When you contact us, we will issue a Return Material Authorization Number for you to 
include with your return. You must return the products to us in their original or equivalent 
packaging, prepay shipping charges, and insure the shipment or accept the risk if the product 
is lost or damaged in shipment. We will return the repaired or replacement products to you. 
We will pay to ship the repaired or replaced products to you if you use an address in Canada. 
Otherwise, we will ship the product to you freight collect.

If we determine that the problem is not covered under this warranty, we will notify you and 
inform you of service alternatives that are available to you on a fee basis.

Individual Home Consumers; Home Office and 

Small Business Customers:

Canada Only

Technical Support and Customer Service 1-800-847-4096

Medium, Large, and Global Commercial Customers; 

Government, Education, and Healthcare 

Customers; and Value-Added Resellers (VARs):

Technical Support 1-800-387-5757

Customer Service 1-800-326-9463

Government or Education Customers, or Individual 

Home Consumers who purchased through an 

Employee Purchase Program:

Technical Support 1-800-387-5757

Customer Service 1-800-326-9463 (Extension 
8221 for Individual 
Consumers)

Dell-Branded Memory 1-888-363-5150
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NOTE: Before you ship the product(s) to us, make sure to back up the data on the hard 

drive(s) and any other storage device(s) in the product(s). Remove any confidential, 

proprietary or personal information, removable media, such as floppy disks, CDs, or PC 

Cards. We are not responsible for any of your confidential, proprietary or personal 

information; lost or corrupted data; or damaged or lost removable media. 

During the remaining years following the first year of all limited warranties: We will replace 
any defective part with new or refurbished parts, if we agree that it needs to be replaced. 
When you contact us, we will require a valid credit card number at the time you request a 
replacement part, but we will not charge you for the replacement part as long as you return 
the original part to us within 30 days after we ship the replacement part to you. If we do not 
receive the original part within 30 days, we will charge to your credit card the then-current 
standard price for that part. 

We will pay to ship the part to you if you use an address in Canada. Otherwise, we will ship 
the part freight collect. We will also include a prepaid shipping container with each 
replacement part for your use in returning the replaced part to us. 

NOTE: Before you replace parts, make sure to back up the data on the hard drive(s) and any 

other storage device(s) in the product(s). We are not responsible for lost or corrupted data. 

What if I purchased a service contract?

If your service contract is with Dell, service will be provided to you under the terms of the 
service contract. Please refer to that contract for details on how to obtain service. Dell's 
service contracts can be found online at www.dell.ca or by calling Customer Care at 1-800-
847-4096. If you purchased through us a service contract with one of our third-party service 
providers, please refer to that contract (mailed to you with your packing slip or invoice) for 
details on how to obtain service. 

How will you fix my product?

We use new and refurbished parts made by various manufacturers in performing warranty 
repairs and in building replacement parts and systems. Refurbished parts and systems are 
parts or systems that have been returned to Dell, some of which were never used by a 
customer. All parts and systems are inspected and tested for quality. Replacement parts and 
systems are covered for the remaining period of the limited warranty for the product you 
bought. Dell owns all parts removed from repaired products. 
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May I transfer the limited warranty?

Limited warranties on systems may be transferred if the current owner transfers ownership of 
the system and records the transfer with us. The limited warranty on Dell-branded memory 
may not be transferred. You may record your transfer by going to Dell’s website: 

• For Canada-purchased computers (in-country transfers) and to transfer from one 
customer to another, go to 
www.dell.ca/ca/en/gen/topics/segtopic_ccare_nav_013_ccare.htm

• For out-of-country transfers (outside of the original country of purchase), go to 
www.dell.com/us/en/biz/topics/sbtopic_ccare_nav_016_ccare.htm

If you do not have Internet access, call Dell at 1-800-847-4096 (Home Consumer customers) 
or 1-800-326-9463 (Corporate Commercial or Government customers).

Dell Software and Peripherals (Canada Only)

Third-Party Software and Peripherals Products

Similar to other resellers of software and peripherals, Dell does not warrant third-party 
products. Third-party software and peripheral products are covered by the warranties 
provided by the original manufacturer or publisher only. Third-party manufacturer 
warranties vary from product to product. Consult your product documentation for specific 
warranty information. More information may also be available from the manufacturer or 
publisher.

While Dell offers a wide selection of software and peripheral products, we do not specifically 
test or guarantee that all of the products we offer work with any or all of the various models 
of Dell computers, nor do we test or guarantee all of the products we sell on the hundreds of 
different brands of computers available today. If you have questions about compatibility, we 
recommend and encourage you to contact the third-party software and peripheral product 
manufacturer or publisher directly.

Dell-Branded Peripheral Products

Dell does provide a limited warranty for new Dell-branded peripheral products (products for 
which Dell is listed as the manufacturer) such as monitors, batteries, memory, docking 
stations, and projectors. To determine which limited warranty applies to the product you 
purchased, see the Dell packing slip or invoice and/or the product documentation that 
accompanied your product. Descriptions of Dell's limited warranties are described in 
preceding sections. 
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1-Year End-User Manufacturer Guarantee (Latin America and 

the Caribbean Only)

Guarantee

Dell Computer Corporation ("Dell") warrants to the end user in accordance with the 
following provisions that its branded hardware products, purchased by the end user from a 
Dell company or an authorized Dell distributor in Latin America or the Caribbean, will be 
free from defects in materials, workmanship, and design affecting normal use, for a period of 
1 year from the original purchase date. Products for which proper claims are made will, at 
Dell’s option, be repaired or replaced at Dell’s expense. Dell owns all parts removed from 
repaired products. Dell uses new and reconditioned parts made by various manufacturers in 
performing repairs and building replacement products.

Exclusions

This Guarantee does not apply to defects resulting from: improper or inadequate 
installation, use, or maintenance; actions or modifications by unauthorized third parties or 
the end user; accidental or willful damage; or normal wear and tear.

Making a Claim

Claims must be made in Latin America or the Caribbean by contacting the Dell point of sale 
within the guarantee period. The end user must always supply proof of purchase, indicating 
name and address of the seller, date of purchase, model and serial number, name and address 
of the customer, and details of symptoms and configuration at the time of malfunction, 
including peripherals and software used. Otherwise, Dell may refuse the guarantee claim. 
Upon diagnosis of a warranted defect, Dell will make arrangements and pay for ground 
freight and insurance to and from Dell’s repair/replacement center. The end user must 
ensure that the defective product is available for collection properly packed in original or 
equally protective packaging together with the details listed above and the return number 
provided to the end user by Dell.

Limitation and Statutory Rights

Dell makes no other warranty, guarantee or like statement other than as explicitly stated 
above, and this Guarantee is given in place of all other guarantees whatsoever, to the fullest 
extent permitted by law. In the absence of applicable legislation, this Guarantee will be the 
end user’s sole and exclusive remedy against Dell or any of its affiliates, and neither Dell nor 
any of its affiliates shall be liable for loss of profit or contracts, or any other indirect or 
consequential loss arising from negligence, breach of contract, or howsoever. 

This Guarantee does not impair or affect mandatory statutory rights of the end user against 
and/or any rights resulting from other contracts concluded by the end user with Dell and/or 
any other seller.
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Dell World Trade LP
One Dell Way, Round Rock, TX 78682, USA

Dell Computadores do Brasil Ltda (CNPJ No. 72.381.189/0001-10)
Avenida Industrial Belgraf, 400
92990-000 - Eldorado do Sul – RS - Brasil

Dell Computer de Chile Ltda
Coyancura 2283, Piso 3- Of.302,
Providencia, Santiago - Chile

Dell Computer de Colombia Corporation
Carrera 7 #115-33 Oficina 603
Bogota, Colombia

Dell Computer de Mexico SA de CV
Paseo de la Reforma 2620 - 11° Piso
Col. Lomas Altas 
11950 México, D.F.
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Glossary
802.11 (W I-F I) — A wireless technology standard for mid-range networking 
devices that allows for enabled devices to automatically recognize each other.

BLUETOOTH™ — A wireless technology standard for short-range (10 m [30 ft]) 
networking devices that allows for enabled devices to automatically recognize each 
other.

COMPACTFLASH  CARD — A removable card that is used to expand the 
capabilities of a device. Common types of CompactFlash cards include memory 
and wireless cards.

CRADLE — A device that allows your handheld device to synchronize with a 
computer, recharge its battery, and run on AC power.

DHCP — dynamic host configuration protocol — A communication protocol 
that allows network administrators to manage and automate the assignment of 
Internet Protocol addresses to computers in a network.

IMAP — Internet message access protocol — A standard client/server protocol 
that allows you to access your e-mail from a server. Using IMAP, you can store and 
browse your e-mail on the server.

INFRARED  SENSOR — A port that allows you to transfer data between the 
computer and infrared-compatible devices without using a cable connection.

ISP — Internet service provider — A company that allows you to access its host 
server to connect directly to the Internet, send and receive e-mail, and access 
websites. The ISP typically provides you with a software package, username, and 
access phone numbers for a fee.

LAN — local area network — A computer network covering a small area. A LAN 
usually is confined to a building or a few nearby buildings. A LAN can be 
connected to another LAN over any distance via telephone lines and radio waves 
to form a wide area network (WAN).

PIM — personal information manager — A program that stores and organizes 
your personal information, such as Calendar, Contacts, Messaging, and Tasks.

POP3 — post office protocol 3 — A standard client/server protocol that allows 
you to access your e-mail from a server. Using POP3, you must download your 
e-mail to your local system to view and browse your messages.

RAM — random-access memory — The primary temporary storage area for 
program instructions and data. Any information stored in RAM is lost when you 
perform a reset.
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RAS — remote access server — A type of server that allows users to access a 
network from a remote location.

ROM — read-only memory — Memory that stores data and programs that 
cannot be deleted or written to by the device. ROM, unlike RAM, retains its 
contents after you perform a reset. Some programs essential to the operation of 
your device reside in ROM.

SDRAM — synchronous dynamic random-access memory — A type of DRAM 
that is synchronized with the optimal clock speed of the microprocessor.

SECURE  D IGITAL  CARD — A type of removable memory commonly used in 
digital cameras, handheld devices, cell phones, and other devices. Secure Digital 
cards are approximately the size of a postage stamp.

SERIAL  CONNECTOR — An I/O port often used to connect devices such as a 
handheld digital device or digital camera to your computer.

SMS — short message service — A service that is capable of sending short 
messages to wireless devices.

SMTP — simple mail transfer protocol — A type of protocol used for sending 
and receiving e-mail. SMTP is typically coupled with POP3 or IMAP.

SYNC  CABLE — A cable through which you can connect a handheld device to a 
computer to transfer or synchronize files.

SYNCHRONIZATION — An automated process that replaces the files in one 
location with the most updated files from another location. For example, you can 
synchronize the files on your computer with the files on your handheld device.

TCP/IP — transmission control protocol/Internet protocol — The basic 
communication language of the Internet. TCP/IP can also be used as a 
communication protocol in an intranet or extranet.

USB — universal serial bus — A hardware interface for a low-speed device such 
as a USB-compatible keyboard, mouse, joystick, scanner, set of speakers, printer, 
broadband devices (DSL and cable modems), imaging devices, or storage devices. 
Devices are plugged directly into a 4-pin socket on your computer or into a 
multiport hub that plugs into your computer. USB devices can be connected and 
disconnected while the computer is turned on, and they can also be daisy-chained 
together.

VPN — virtual private network — A set of communication protocols that allows 
remote users to securely access a network.

WAP — wireless application protocol — A standardization for the way that 
wireless devices access the Internet.
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Index

A

ActiveSync

about, 57

installing, 59

appointments

scheduling, 63

audio

Media player, 88

notifications, 74

AvantGo

about, 92

B

battery

charging, 22

main, 21

using and installing, 21

block recognizer, 44

Bluetooth

settings, 55

buttons

about, 32

Calendar, 19

Contacts, 19

Home, 19

locations, 18

Messaging, 19

navigator, 19

buttons (continued)

power, 19

program buttons, 35

record, 19

reset, 20

scroll dial, 19

C

Calendar

about, 62

appointments, 63

meeting requests, 64

command bar, 37

communicating

with other devices, 95

CompactFlash

slot, 18

computer

connecting to, 23

Contacts

about, 65

creating, 65

finding, 66

cradle

connecting to a computer, 23
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D

data

backing up, 40

disconnecting

dial-up connection, 101

from a cable or cradle, 101

from a network, 101

infrared sensor, 101

drawing

creating, 49

E

editing

written text, 46

e-mail

composing messages, 72

connecting to a server, 70, 102

message list, 70

Messaging, 69

organizing, 73

synchronizing, 69

ethernet connection, 99

Excel

about, 84

tips, 86

expansion slots

locations, 18

F

files

backing up, 40

File Explorer, 78

finding, 78

finding and organizing, 39

synchronizing, 57

finding information, 15

contacting Dell, 125

H

help

ActiveSync Help, 102

contacting Dell, 125

finding, 102

Pocket PC Help, 15

I

icons

program, 36

status, 34

infrared

using, 96

input panel, 42

Internet

connecting to, 95
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Internet Explorer

about, 89

browsing the web, 92

favorite links, 91

mobile favorites, 90-91

K

keyboard

soft, 43

L

letter recognizer, 43

M

Media Player

about, 88

meeting requests

creating, 64

memory

conserving, 91

Messaging

about, 69

microphone

recording a message, 50

modem connection, 98

MSN Messenger

about, 86

setting up, 87

working with contacts, 87

My Text

inserting, 51

N

navigation bar, 37

network

connecting to, 95

Notes

creating, 68

notifications

about, 74

P

Pocket Outlook

about, 62

Pocket PC

getting started, 31

pop-up menus, 38

print-style text

converting written text 
to, 43-44

programs

accessing, 35

ActiveSync, 57

adding and removing, 75

adding programs using 
ActiveSync, 76

AvantGo, 92

Calendar, 62

Contacts, 65

downloading, 77
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programs (continued)

Media Player, 88

Messaging, 69

MSN Messenger, 86

Notes, 68

Pocket Excel, 84

Pocket Internet Explorer, 89

Pocket Outlook, 62

Pocket Word, 82

removing, 79

Start menu, 78

Switcher Bar, 36

Tasks, 66

R

recording

voice messages, 50

reminders. See notifications

reset

button, 20

performing, 28

resources

finding, 15

S

safety instructions, 11

scroll dial, 19

Secure Digital card slot

installing cards, 27

location, 18

Service Tag, 16, 22

settings

adjusting, 53

Connections tab, 55

Personal tab, 54

System tab, 54

software. See programs

specifications, 104

stylus

using, 32

writing methods, 41

Switcher Bar, 36

sync cable

connecting to a computer, 26

synchronizing

with your computer, 23

T

Tasks

about, 66

creating, 66

text

converting written text to 
print-style text, 43-44

editing, 45-46

input panel, 42

typing, 43

written, 43-45

Today screen, 32

transcriber, 44
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V

video

Media Player, 88

VPN connection, 100

W

warranty, 153

Word

about, 82

writing

block recognizer, 44

converting written text to 
print-style text, 43-44

drawing, 49

editing, 45

letter recognizer, 43

methods, 41

on the screen, 45

transcriber, 44



172 Index


